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Récapitulatif

Les informations suivantes sont fournies aux clients GE Healthcare Technologies en ce qui concerne les vulnérabilités de sécurité technique connues liées & Mac-Lab® Hemodynamic,
CardioLab® Electrophysiology, SpecialsLab et les systémes d'enregistrement Combolab IT pour Cath Lab, EP Lab et d'autres laboratoires d'intervention ainsi que les systémes de
gestion des données de cardiologie Centricity®.

Configuration de base de correctifs de sécurité

La configuration de base de correctifs de sécurité des systémes Mac-Lab IT/XT/XTi et CardioLab IT/XT/XTi au moment de la sortie est indiquée dans la configuration de base MLCL, a la
section Hemodynamic, Electrophysiology and Cardiovascular Information Technologies du site Web

http:.//www3.gehealthcare.com/en/Support/Invasive_Cardiology Product Security.

Processus
Les actions suivantes sont effectuées a chaque fois que Microsoft ou autres fabricants publient de nouveaux correctifs de sécurité :
e L'équipe d'ingénierie de cardiologie invasive effectue un processus d'analyse de sécurité sur le matériel et les logiciels pris en charge par Mac-Lab IT/XT/XTi, CardioLab
IT/XT/XTi, GE Client Review et le serveur INW.
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e Siune vulnérabilité répond aux critéres de validation de Mac-Lab IT/XT/XTi et CardioLab IT/XT/XTi, la vulnérabilité est communiquée par le biais de la base de données de
sécurité produit GEHC et le site Web Invasive Cardiology Security dans les trois semaines suivant la sortie de la version du correctif.

e Déslavalidation de la vulnérabilité Mac-Lab IT/XT/XTi et CardioLab IT/XT/XTi, les instructions d'installation de la base de données de sécurité produit GEHC, du site Web
Invasive Cardiology Security et du Mac-Lab IT/XT/XTi et CardioLab IT/XT/XTi atteints sont mises a jour.

Les critéres de validation de vulnérabilité du Mac-Lab IT/XT/XTi et du CardioLab IT/XT/XTi sont comme suit : Toute vulnérabilité qui permet aux logiciels malveillants de modifier ou de
refuser les fonctionnalités Mac-Lab IT/XT/XTi et CardioLab IT/XT/XTi et/ou d'infecter et se propager par une utilisation normale du systéme.

Les clients doivent rester informés par les notifications en vulnérabilité de Microsoft et visiter les sites Web de cardiologie invasive pour comprendre l'impact sur Mac-Lab IT/XT/XTi et
CardioLab IT/XT/XTi. Une fois qu'un correctif de sécurité est validé, les clients sont responsables de son installation. Toutes les instructions d'installation des correctifs de sécurité pour
Mac-Lab IT/XT/XTi et CardioLab IT/XT/XTi sont disponibles sur le site Web Invasive Cardiology Security sous le tableau des correctifs validés.

Les vulnérabilités exposées apres la sortie produit Mac-Lab IT/XT/XTi et CardioLab IT/XT/XTi qui ne répondent pas aux critéres pour étre validées ne sont pas énumérés dans base de
données de sécurité produit GEHC et le site Web Invasive Cardiology Security. Ces vulnérabilités sont considérés comme non critiques et/ou en dehors du flux de travail clinique des
systémes Mac-Lab IT/XT/XTi, CardioLab IT/XT/XTi et Centricity INW et ne seront pas validées. Les correctifs non répertoriés ne doivent pas étre installés sur les produits afin d'éliminer
les risques de dysfonctionnement et de panne.
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Historique des révisions

Révision Date Commentaires
1.0 22 septembre 2017 e 6.9.6 Séparation de document
e B4025341qualifié - Rollup mensuel juillet
e Chemins d'installation 6.9.6 ajoutés pour simplifier l'installation des correctifs
e Correctifs non qualifiés de septembre
2.0 13 octobre 2017 e Instructions ajoutées pour désactiver le protocole SMB1
30 27 octobre 2017 e Correctifs non qualifiés d'octobre
4.0 20 novembre 2017 e Correctifs qualifiés d'octobre ajoutés
5.0 11 décembre 2017 e Correctifs non qualifiés de novembre
6.0 20 décembre 2017 e Pour le correctif mensuel d'octobre, consignes ajoutées pour désinstaller les correctifs mensuels
précédents avant I'installation du correctif mensuel d'octobre sur le serveur
7.0 26 janvier 2018 e Rollups qualifiés mensuels de novembre et décembre avec d'autres correctifs. Correctifs non qualifiés
de janvier également ajoutés
8.0 9 mars 2018 e Correctifs non qualifiés de février ajoutés
e Modifications qualifiées de la longueur minimale du mot de passe
e Formulation modifiée de « Actualisation de correctif » en « Mises a jour de correctif »
e Recommandations supplémentaires sur la sécurité des systemes MLCL
9.0 20 avril 2018 e Correctifs qualifiés de janvier, février, mars et avril ajoutés
e Section « Recommandations supplémentaires sur la sécurité des systemes MLCL » mise a jour et
section « Mises @ jour de sécurité facultatives » déplacée
10.0 30 avril 2018 e Section « Suppression facultative de Adobe Reader sur le serveur INW » ajoutée @ la section
facultative
e Correctif non qualifié d'avril ajouté
11.0 17 mai 2018 e Correctifs qualifiés de mai ajoutés
e Correctifs .NET pour les versions 3.5 SP1, 4.5.2, ajoutés
e Correctifs Microsoft Office ajoutés
12 29 juin 2018 e Correctif non qualifié de juin ajouté
13 5 septembre 2018 e Correctif non qualifié d'aolt ajouté
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14

18 septembre 2018

Correctifs qualifiés de juin, juillet, aolt et septembre
Correctifs qualifies .Net Framework

Correctifs qualifiés Microsoft Office 2010

Mise @ jour qualifiée de 2440 BIOS

Mise d jour qualifiée de ML350 Gen9 BIOS

15

5 décembre 2018

Correctif non qualifié d'octobre ajouté

16

10 mai 2019

Octobre 2018, novembre 2018, décembre 2018, janvier 2019, février 2019 et mars 2019 qualifiés
Correctifs qualifies .Net Framework

Correctifs qualifies Microsoft Office 2010

Instructions ajoutées pour désactiver le protocole 3DES

Instructions ajoutées pour désactiver le protocole SMBv2

Instructions ajoutées pour désinstaller Codemeter

Instructions ajoutées pour nettoyer C:\ Disque dur

Instructions ajoutées pour supprimer les utilisateurs authentifiés du serveur INW
Installation et configuration de Adobe Reader DC MUI gjoutées

Disposition du document agjoutée

Images anciennes et nouvelles ajoutées

17

24 mai 2019

Correctifs qualifiés d'avril et mai 2019
Instructions ajoutées pour I'option de désactiver Remote Desktop Services

18

21 juin 2019

Informations manquantes du fichier cab pour KB4461623 mises a jour

Section « MLCL V6.9.6 2018 Mises @ jour de correctif 6 » renommée « MLCL V6.9.6 2019 Mises a jour
de correctif 6 »

Section « MLCL V6.9.6 2018 Mises a jour de correctif 7 » renommée « MLCL V6.9.6 2019 Mises a jour
de correctif 7 »

19

27 juin 2019

Correctifs non qualifiés de juin 2019 agjoutés
Instructions pour désactiver le protocole 3DES supprimées

20

22 juillet 2019

Les mises a jour remplacent les correctifs Adobe antérieurs a Adobe DC
Instructions ajoutées pour supprimer les utilisateurs authentifiés du serveur INW

21

2 ao(t 2019

Correctifs qualifiés de juin et juillet 2019
Correctifs qualifies .Net Framework
Correctifs qualifiés Microsoft Office 2010
Correctif qualifié Adobe
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22 16 aolt 2019 e Informations sur les fichiers d'installation pour KB4507420 ajoutées
e Rollup mensuel qualifié d'aolt 2019

23 21 aolt 2019 e URLKB4019112 pour Windows Server 2008 R2 de la section « MLCL V6.9.6 2019 Mises & jour de
correctif 7 » mise @ jour.

e Consigne d'installation de KB4487078 ajoutée dans la section « MLCL V6.9.6 2019 Mises a jour de
correctif 7 ».

e Consigne d'installation de KB4487121 ajoutée dans la section « MLCL V6.9.6 2019 Mises a jour de
correctif 7 ».

e Section « Nettoyage du disque C: » mise a jour avec des instructions pour libérer de I'espace sur le
disque dur.

24 18 octobre 2019 e « Mises a jour du correctif » mise a jour avec des détails relatifs aux images applicables.

Disposition du document

Le document est structuré pour afficher
e Configuration requise pour l'installation des correctifs
Comment confirmer la version de I'application 6.9.6
Chemins d'installation
Comment se connecter au systeme
Sous-sections référencées a partir des sections de mise @ jour de correctif
Correctifs non qualifiés
Sections de mise a jour de correctif
Section de mise @ jour de sécurité facultative

Installation des correctifs de sécurité sur les systemes MLCL
Configurations requises :
e Lesmises & jour peuvent s'appliquer a tout moment sauf quand l'application Mac-Lab IT/XT/XTi, CardioLab IT/XT/XTi ou SpecialsLab est ouverte.
e Lesmises a jour doivent étre ré-appliquées si le systéeme est ré-imagé.
Les mises & jour s'appliquent & la fois aux systéemes en réseau et autonomes.
e Lameilleure pratique consiste & mettre @ jour tous les systéemes MLCL applicables sur site. Ce document contient la liste des correctifs qualifiés pour les systéemes INW Server
(Windows Server 2008 R2), Acquisition (Windows 7), Examen (Windows 7) et Examen virtuel (Windows 7).
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Ce document s'applique a 6.9.6R3 uniquement. Veuillez vérifier que vous exécutez bien 6.9.6 en utilisant la procédure suivante avant de continuer :

Lancez I'application Mac-Lab CardioLab & partir du systéme d'acquisition ou d'examen.
Sélectionnez Help > About Mac-Lab (Aide > A propos de Mac-Lab) (ou CardiolLab, le cas échéant).
Vérifiez que le numéro de version est bien 6.9.6 Version 3.

Cliquez sur Close (Fermer).

Fermez l'application.

kW e

Recommandations : Utilisez Internet Explorer (IE) pour télécharger le catalogue. Si vous utilisez le panier pour télécharger des correctifs, vous devez ouvrir un autre onglet ou
une nouvelle fenétre http://catalog.update.microsoft.com pour voir le contenu du panier.

Chemins d'installation 6.9.6

Il existe plusieurs chemins d'installation en fonction de la version de 6.9.6 installée et des correctifs installés précédemment. Les renseignements suivants vous guideront vers le
chemin d'installation correct.

Déterminez la version du 6.9.6 que vous exécutez. Cette opération peut étre effectuée & partir de I'application Mac-Lab/CardioLab et en accédant & Help/About (Aide/A propos) comme
indiqué ci-dessus. Le numéro de version associé au scénario d'installation détermine le chemin correct. Ce document s'applique a 6.9.6R3 uniquement.

Remarque : la section MLCL Optional Security Updates (Mises & jour de sécurité en option MLCL) peut étre appliquée une fois tous les autres correctifs / toutes les mises a jour
appliquélels. Les mises & jour facultatives fournissent une sécurité supplémentaire, mais ne sont pas nécessaires. Vous pouvez appliquer certains des correctifs en option, mais choisir
d'ignorer les autres. Par exemple, vous pouvez choisir de désactiver certains des protocoles vulnérables ou de ne pas activer le hachage faible en raison des cots et de la complexité
de la gestion des certificats. Cela ne causera aucun probléme. Cependant, toutes les autres mises d jour sont fortement recommandées.

Déterminez la version d'image de 6.9.6 que vous exécutez en suivant ces étapes ;

1) Connectez-vous aux systéemes MLCL (ACQ, GE REVIEW, INW, VIRTUAL REVIEW) en tant qu'utilisateur disposant de privileges d'administration, par exemple Administrateur.
2) Sélectionnez Windows Start -> Run (Démarrer - > Exécuter), tapez Regedit et Entrée.
3) Dans la fenétre Regedit, accédez a HKEY_LOCAL_MACHINE\SOFTWARE\GE Medical Systems
4) Cliquez sur GE Medical Systems
5) Double-cliquez sur Image Version (Version d'image)
6) Comparez Value Data (Données de la valeur) au tableau ci-dessous pour déterminer si vous exécutez une image ancienne ou nouvelle
7) Quittez la boite de dialogue Regedit.
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Systéeme MLCL Anciennes versions d'image Nouvelles versions d'image
ACQ 10192016 12132018
GE REVIEW 10192016 12132018
INW 10192016 12142018
VIRTUAL REVIEW 10282016 12172018

Certaines mises a jour sont documentées comme remplacées. Celles-ci sont laissées dans le document & des fins d'intégralité, mais peuvent étre ignorées.
L'un des scénarios suivants s'appliquera @ l'installation :

(1) Nouvelle configuration ou recréation d'image d'une machine pour une reprise apres sinistre a l'aide de I''mage
(a) Silesysteme a été configuré a I'aide de I'ancienne image, appliquez les mises @ jour de la section suivante.
(il MLCLV6.9.6 2017 Mises a jour de correctif 1 (Ne s'applique qu'a I'ancienne image)
(i) MLCLV6.9.6 2017 Mises a jour de correctif 2 (Ne s'applique qu'a I'ancienne image)
(i) MLCL V6.9.6 2018 Mises a jour de correctif 3 (Ne s'applique qu'a I'ancienne image)
(iv) MLCL V6.9.6 2018 Mises a jour de correctif 4 (Ne s'applique qu'a I'ancienne image)
(v} MLCLV6.9.6 2018 Mises a jour de correctif 5 (Ne s'applique qu'a I'ancienne image)
(vi) MLCLV6.9.6 2019 Mises a jour de correctif 6 (Ne s‘applique qu'a I'ancienne image)
(vii) MLCL V6.9.6 2019 Mises a jour de correctif 8 (S'applique a I'ancienne et a la nouvelle image)

(b) Sile systeme a été configuré a I'aide de la nouvelle image, appliquez les mises a jour de la section suivante
(i) MLCLV6.9.6 2019 Mises a jour de correctif 7 (Ne s'applique qu'a la nouvelle image)
(i) MLCLV6.9.6 2019 Mises a jour de correctif 8 (S'applique a I'ancienne et a la nouvelle image)

(2) La machine a été configurée et corrigée initialement avec des correctifs qualifiés au moment de ['installation
(a) Vous devez connaitre les correctifs a partir desquels les sections de mises a jour de correctifs ont été installées au moment de l'installation et si le systeme a été
configuré a l'aide de I'ancienne ou de la nouvelle image.
() Surlabase d'une nouvelle ou d'une ancienne image et des correctifs installés au moment de l'installation ou de la recréation d'image, des correctifs qualifiés
provenant de la liste des correctifs nouvellement qualifiés, sous différentes sections de mise a jour des correctifs et une section de mise @ jour de sécurité
facultative, doivent étre installés.

Procédure de connexion aux systémes d'acquisition et d'examen
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Lors du démarrage du systeme d'acquisition et d'examen Mac-Lab, CardioLab ou SpecialsLab, une séquence de connexion automatique commence et se connecte automatiquement
au systéme d'exploitation. Pour installer un correctif de sécurité, I'utilisateur doit étre connecté comme milcltechuser.

REMARQUE : Le mot de passe est contenu dans le manuel de sécurité. Sinon, contactez I'administrateur systéme ou le support technique GE pour obtenir le mot de passe actuel.

O NOUTE WNE

Mise sous tension du systeme d'acquisition.

Le systéme démarre avec la fenétre d'identification personnalisée.

Appuyez sur Ctrl + Alt + Suppr.

Cliquez sur Logoff (Déconnexion). Sur Windows XP, cliquez sur Logoff (Déconnexion) a nouveau.
Cliquez sur OK.

Maintenez immédiatement la touche Maj. jusqu'a ce que la page de connexion s'affiche.
Connectez-vous localement au systéme d'exploitation mlcltechuser.

Connectez-vous localement a la fenétre d'identification personnalisée en tant que micltechuser.

Comment se connecter au serveur Centricity Cardiology INW

Le mot de passe est contenu dans le manuel de sécurité. Sinon, contactez I'administrateur systéme ou le support technique GE pour obtenir le mot de passe actuel. Connectez-vous au
serveur INW en tant qu'administrateur

Comment se connecter aux systémes MLCL logiciel seul

Puisque les systémes logiciel seul sont pris en charge par le client, le systeme doit étre connecté avec un compte administrateur.

Comment installer un micrologiciel d'imprimante

Le systeme qui appliquera le micrologiciel de l'imprimante doit étre fourni par le client.
REMARQUE : le systeme Mac-Lab CardioLab ne doit pas étre utilisé pour télécharger et/ou appliquer le micrologiciel de I'imprimante.

Suivez le lien de téléchargement dans le tableau.

Sélectionnez l'imprimante appropriée.

Sélectionnez Francais et le systéeme d'exploitation MLCL applicable.

Sélectionnez Francais et dans la catégorie Micrologiciel sélectionnez I'utilitaire de mise @ jour du micrologiciel applicable et cliquez sur Download (Télécharger).
Lancez l'installation du micrologiciel et suivez les instructions complétes pour terminer la mise @ jour du micrologiciel.

Comment mettre a jour Intel Management Engine Firmware (HP Z440) - HPSBHF03557 Rév. 1
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1. Connectez-vous au SE Windows et a la fenétre d'identification personnalisée MLCL en tant que micltechuser.

Accédez a I'emplacement a l'intérieur de la section MLCL V6.9.6 Mises a jour de correctif, qui contient le fichier de mise & jour du micrologiciel Intel Management Engine
sp80050.exe.

Faites un clic droit sur sp80050.exe et sélectionnez Run as administrator (Exécuter en tant qu'administrateur).

Cliquez sur Yes (Oui) dans la boite de dialogue User Account Control (Contrdle de compte d'utilisateur).

Cliquez sur Next (Suivant) dans l'assistant Install Shield.

Acceptez le contrat de licence et cliquez sur Next (Suivant).

Appuyez sur Y a l'invite de commande « Do you want to update the Management Engine Firmware now [Y/N] ?» (Voulez-vous mettre a jour le micrologiciel de gestion de
moteur maintenant [O/N] ?).

8. Redémarrez le systeme une fois la mise & jour du micrologiciel terminée.

N

No o bEW

Mesures pour vérifier que la mise & jour du micrologiciel a réussi:

1. Apres le redémarrage du systéme, & l'intérieur de I'écran HP appuyez sur F10 pour accéder au menu de configuration.
2. Allez sur Main > System Information (Principal > Informations systeme).
3. Laversion du micrologiciel ME doit étre 9.1.41.3024.

Instructions de mise a jour de 2440 BIOS a v2.34 :

1. Rendez-vous a la section Assistance clientéle HP - Site Web de téléchargement de logiciels et pilotes :

https://support.hp.com/us-en/drivers/selfservice/hp-z440-workstation/6978828

Sélectionnez BIOS.

Sélectionnez Download (Télécharger) pour HP Z440/Z640/Z840 Workstation System BIOS 2.34 Rev.A.

Connectez-vous @ l'ordinateur z440 en tant qu'administrateur.

Exécutez le fichier téléchargé sp80745.exe.

Sélectionnez Yes (Oui) pour autoriser.

Sélectionnez I accept the terms in the license agreement (J'accepte les termes du contrat de licence).

Sélectionnez View Contents of the HPBIOSUPDREC folder (Afficher le contenu du dossier HPBIOSUPDREC). Cela ouvre le dossier :

O N AW

C:\\swsetup\SP80745\HPBIOSUPDREC
9. Exécutez HPBIOSUPDREC.exe.
10. Sélectionnez Yes (Oui) pour autoriser.
11. Aprés plusieurs secondes, un fichier journal est créé et une fenétre d'utilitaire d'installation apparait. Sélectionnez Update (Mettre a jour) et Next (Suivant).
12. Suivez les instructions a I'écran, sélectionnez Restart (Redémarrer).
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13.

14.

La mise a jour du BIOS ne prendra que quelques minutes, ne coupez pas I'alimentation pendant la mise @ jour. L'ordinateur va redémarrer deux fois au cours de cette mise
jour.
Apreés la mise a jour, sur le premier écran de démarrage avant que Windows se lance, vérifiez que la version 2.34 du BIOS apparait en bas & gauche de ['écran.

Instructions de mise a jour de 2440 BIOS a v2.45 :

1.

N B W

9.

10.
11.
12.
13.

14.

Rendez-vous d la section Assistance clientéle HP - Site Web de téléchargement de logiciels et pilotes :

https://support.hp.com/us-en/drivers/selfservice/hp-z440-workstation/6978828

Sélectionnez BIOS.

Sélectionnez Download (Télécharger) pour HP Z440/Z640/Z840 Workstation System BIOS 2.45 Rev.A.

Connectez-vous & l'ordinateur z440 en tant qu‘administrateur.

Exécutez le fichier téléchargé sp88253.exe.

Sélectionnez Yes (Oui) pour autoriser.

Sélectionnez I accept the terms in the license agreement (J'accepte les termes du contrat de licence).

Sélectionnez View Contents of the HPBIOSUPDREC folder (Afficher le contenu du dossier HPBIOSUPDREC). Cela ouvre le dossier :

C:\\swsetup\SP88253\HPBIOSUPDREC

Exécutez HPBIOSUPDREC.exe.

Sélectionnez Yes (Oui) pour autoriser.

Apres plusieurs secondes, un fichier journal est créé et une fenétre d'utilitaire d'installation apparait. Sélectionnez Update (Mettre @ jour) et Next (Suivant).

Suivez les instructions & I'écran, sélectionnez Restart (Redémarrer).

La mise a jour du BIOS ne prendra que quelgues minutes, ne coupez pas I'alimentation pendant la mise & jour. L'ordinateur va redémarrer deux fois au cours de cette mise d
jour.

Apreés la mise a jour, sur le premier écran de démarrage avant que Windows se lance, vérifiez que la version 2.45 du BIOS apparait en bas & gauche de I'écran.
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Instructions de mise a jour de 2440 BIOS a v2.47 :
1. Rendez-vous @ la section Assistance clientéle HP - Site Web de téléchargement de logiciels et pilotes :

https://support.hp.com/us-en/drivers/selfservice/hp-z440-workstation/6978828

Sélectionnez BIOS.

Sélectionnez Download (Télécharger) pour HP Z440/2640/Z840 Workstation System BIOS 2.47 Rev.A.

Connectez-vous & l'ordinateur z440 en tant qu‘administrateur.

Exécutez le fichier téléchargé sp93482.exe.

Sélectionnez Yes (Oui) pour autoriser.

Sélectionnez I accept the terms in the license agreement (J'accepte les termes du contrat de licence).

Sélectionnez View Contents of the HPBIOSUPDREC folder (Afficher le contenu du dossier HPBIOSUPDREC). Cela ouvre le dossier :

N LB W

C:\\swsetup\SP93482\HPBIOSUPDREC

9. Exécutez HPBIOSUPDREC.exe.

10. Sélectionnez Yes (Oui) pour autoriser.

11. Apres plusieurs secondes, un fichier journal est créé et une fenétre d'utilitaire d'installation apparait. Sélectionnez Update (Mettre a jour) et Next (Suivant).

12. Suivez les instructions a I'écran, sélectionnez Restart (Redémarrer).

13. La mise @ jour du BIOS ne prendra que quelques minutes, ne coupez pas l'alimentation pendant la mise & jour. L'ordinateur va redémarrer deux fois au cours de cette mise a
jour.

14. Apreés la mise @ jour, sur le premier écran de démarrage avant que Windows se lance, vérifiez que la version 2.47 du BIOS apparait en bas & gauche de I'écran.

Instructions de mise a jour de ML350 Gen9 BIOS a v2.56 :

1. Rendez-vous ¢ la section Assistance clientéle HP - Site Web de téléchargement de logiciels et pilotes :
https://support.hpe.com/hpsc/swd/public/detail?switemId=MTX_ 116f29414b06465c96e6bd94ae
Sélectionnez Download (Télécharger) pour HP ML350 Gen9 Server BIOS 2.56

Connectez-vous au serveur ML350 Gen9 en tant qu'administrateur.

Exécutez le fichier téléchargé cp034882.exe.

Cliquez sur Run (Exécuter)

Cliquez sur Install (Installer)

Suivez les instructions @ I'écran et sélectionnez Close (Fermer) une fois l'installation terminée.

Sélectionnez Yes (Oui) pour redémarrer.

9. Lamise ajour du BIOS ne prendra que quelgues minutes, ne coupez pas I'alimentation pendant la mise a jour.
10. Apres la mise a jour, sur le premier écran de démarrage avant que Windows se lance, vérifiez que la version 2.56 du BIOS apparait en bas & gauche de ['écran.
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Instructions de mise a jour de ML350 Gen9 BIOS vers la version du 21/5/2018 :

1.

2
3
4
5.
6.
7
8
9.
1

Rendez-vous ¢ la section Assistance clientéle HP - Site Web de téléchargement de logiciels et pilotes :
https://support.hpe.com/hpsc/swd/public/detail?sp4ts.oid=1009483731&swlitemId=MTX_ 2fadlbbda82e4d5ca0673alb438&swWENvOid=4184
Sélectionnez Download (Télécharger) pour HP ML350 Gen9 Server BIOS 5/21/2018

Connectez-vous au serveur ML350 Gen9 en tant qu'administrateur.

Exécutez le fichier téléchargé cp035797.exe.

Cliquez sur Run (Exécuter)

Cliquez sur Install (Installer)

Suivez les instructions @ I'écran et sélectionnez Close (Fermer) une fois l'installation terminée.

Sélectionnez Yes (Oui) pour redémarrer.

La mise a jour du BIOS ne prendra que quelques minutes, ne coupez pas I'alimentation pendant la mise & jour.

0. Apres la mise a jour, sur le premier écran de démarrage avant que Windows se lance, vérifiez que la version du 21/5/2018 du BIOS apparait en bas a gauche de I'écran.

FACULTATIF - Comment installer I'amélioration des performances du serveur INW

Les correctifs suivants ne permettent pas de résoudre les problemes de sécurité et sont en option. Ces correctifs peuvent améliorer les performances du réseau. La procédure
d'installation ci-dessous doit étre suivie et tous les correctifs déployés ensemble. Ce déploiement peut prendre jusqu'a 12 heures, le grand pourcentage au sein de l'installation
KB2775511.

1.

A l'aide d'un systéme non-MLCL, consultez et téléchargez les correctifs suivants sur un support amovible.

Visitez la page http://catalog.update.microsoft.com/ et entrez ci-dessous les numéros KB pour accéder aux correctifs.
KB2775511 - http://support.microsoft.com/kb/2775511

KB2732673 - http://support.microsoft.com/kb/2732673

KB2728738 - http://support.microsoft.com/kb/2728738

KB2878378 - http://support.microsoft.com/kb/2878378

Les correctifs suivants sont répertoriés dans l'article suivant : KB2473205 - https://support.microsoft.com/en-us/kb/2473205

KB2535094 - http://support.microsoft.com/kb/2535094 Téléchargement sur - https://support.microsoft.com/en-us/hotfix/kbhotfix?kbnum=2535094&kbIin=en-us
KB2914677 - http://support.microsoft.com/kb/2914677 Téléchargement sur - https://support.microsoft.com/en-us/hotfix/kbhotfix?kbnum=29146778&kbin=en-us
KB2831013 - http://support.microsoft.com/kb/2831013 Téléchargement sur - https://support.microsoft.com/en-us/hotfix/kbhotfix?kbnum=2831013&kbIn=en-us
KB3000483 - http://support.microsoft.com/kb/3000483 Téléchargement sur - http://catalog.update.microsoft.com/
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10.
11.
12.
13.

KB3080140 - http://support.microsoft.com/kb/3080140 Téléchargement sur - http://catalog.update.microsoft.com/
KB3044428 - http://support.microsoft.com/kb/3044428 Téléchargement sur - https://support.microsoft.com/en-us/hotfix/kbhotfix?kbnum=3044428&kbIin=en-us

Connectez-vous au serveur INW en tant qu'administrateur.

Insérez le support amovible et installez les correctifs dans I'ordre indiqué ci-dessus.

Suivez les instructions d'installation de Microsoft pour terminer l'installation des correctifs.

Sélectionnez Windows Start -> Run (Démarrer - > Exécuter), tapez Regedit et Entrée.

Dans la fenétre Regedit , accédez  HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\services\Tcpip

Dans la boite de dialogue Menu, sélectionnez File -> Export (Fichier - > Exporter). Nommez le fichier MLCLRegSave.reg et placez-le dans le répertoire C:\Temp.
Dans la fenétre Regedit, a partir de tcpip accédez aux Parameétres.

Dans la boite de dialogue Menu, sélectionnez Edit -> New -> DWORD (32-bit) Value (Modifier - > Nouveau - > Valeur DWORD [32 bits]). Une nouvelle entrée est créée,
nommez-la "MaxUserPort".

Cliquez & droite sur "MaxUserPort", sélectionnez Modify (Modifier) et entrez la valeur 65534 avec une base Décimale.

Suivez la méme procédure ci-dessus et créez une nouvelle entrée nommée ‘TcpTimedWaitDelay'. Entrez la valeur 60 avec une base Décimale.

Quittez la boite de dialogue Regedit.

Redémarrez le serveur INW.

FACULTATIF - Comment installer le plug-in 20007 - Désactiver SSL V2/V3 - KB187498

A NS

o

O o N o

10.
11.

Connectez-vous en tant gu'administrateur ou membre de ce groupe.

Ouvrez une invite de commande et entrez les commandes suivantes :

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\SSL 2.0" /f

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\SSL 2.0\Client" /v DisabledByDefault /t REG_DWORD /d
00000001 /f

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\SSL 2.0\Server" /v DisabledByDefault /t REG_DWORD /d
00000001 /f

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Contro\SecurityProviders\SCHANNEL\Protocols\SSL 2.0\Server" /v Enabled /t REG_DWORD /d 00000000 /f
REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\SSL 3.0" /f

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\SSL 3.0\Server" /f

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\ControN\SecurityProviders\SCHANNEL\Protocols\SSL 3.0\Server" /v DisabledByDefault /t REG_DWORD /d
00000001 /f

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\SSL 3.0\Server" /v Enabled /t REG_DWORD /d 00000000 /f
Fermez l'invite de commande.
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FACULTATIF - Comment installer le plug-in 35291 - Hachage faible

1) Chargez votre certificat de sécurité dans le server SQL sur chaque systeme ML/CL dans le réseau (serveur, acquisitions, évaluations et examens virtuels) ou acquisition ML/CL
autonome.
2) Désactivez le RDP sur chaque membre du réseau.
a) My Computer>Properties>Remote settings>Remote (Mon Ordinateur > Propriétés > Paramétres > A distance)
b) Cochez I'option « Don't allow connections to this computer » (Ne pas autoriser les connexions d cet ordinateur).
c) Cliquez sur OK et redémarrez.

FACULTATIF - Comment installer le plug-in 65821 - Suites de chiffrement SSL RC4 prises en charge

Connectez-vous en tant gu'administrateur ou membre de ce groupe.

Ouvrez une invite de commande et entrez les commandes suivantes :

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Contro\SecurityProviders\SCHANNEL\Ciphers\RC4 128/128" /f

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControISet\ControI\SecuritgProviders\SCHANNEL\Ciphers\RC4 128/128" /v Enabled /t REG_DWORD /d 00000000 /f
REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Ciphers\RC4 40/128" /f

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Ciphers\RC4 40/128" /v Enabled /t REG_DWORD /d 00000000 /f
REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Contro\SecurityProviders\SCHANNEL\Ciphers\RC4 56/128" /f

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Ciphers\RC4 56/128" /v Enabled /t REG_DWORD /d 00000000 /f
Fermez l'invite de commande.

O oo NOOLE NN

FACULTATIF - Comment supprimer une vulnérabilité pour le plug-in 63155 - Enumération de chemin d'accés du
service Microsoft Windows sans guillemets

1. Connectez-vous en tant qu'administrateur ou membre de ce groupe.
2. Ouvrez Regedit pour effectuer les actions suivantes :
a. Sous Windows 7
i. Accédez a HKLM\System\CurrentControlset\Services\RtkAudioService
ii. Remplacez la valeur de la clé du chemin d'acces de I''mage :
C:\Program Files\Realtek\Audio\HDA\RtkAudioService.exe
par:
“C:\Program Files\Realtek\Audio\HDA\RtkAudioService.exe"
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Remarque : les guillemets avant et arriére font partie de la valeur de la clé. Les guillemets permettent de supprimer la vulnérabilité.

b. Sous Windows 2008R2
i. Accédez a HKLM\System\CurrentControlset\Services\Gems Task Scheduler
ii. Remplacez la valeur de la clé du chemin d'accés de I'image :
C:\Program Files (x86)\GE Healthcare\MLCL\Bin\ArchiveUtility\GEMS_TaskSvc.exe
par:
“C:\Program Files (x86)\GE Healthcare\MLCL\Bin\ArchiveUtility\GEMS_TaskSvc.exe"
Remarque : les guillemets avant et arriere font partie de la valeur de la clé. Les guillemets permettent de supprimer la vulnérabilité.

FACULTATIF - Comment désactiver le Protocole SMB1

REMARQUE : La désactivation de SMB1 peut entrainer une interface VIVID non fonctionnelle avec le systéme d'acquisition
Connectez-vous en tant qu'administrateur ou membre de ce groupe.

Ouvrez une invite de commande et entrez les commandes suivantes :

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\LanmanServer\Parameters" /f

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\LanmanServer\Parameters" /v SMB1 /t REG_DWORD /d 00000000 /f
sc.exe config lanmanworkstation depend= bowser/mrxsmb20/nsi

sc.exe config mrxsmb10 start= disabled

oOuEWNNE

FACULTATIF - Configuration de la signature SMBv2 requise - Signature SMBv2 non requise

REMARQUE : La signature SMBV2 peut entrainer une interface VIVID non fonctionnelle avec le systéme d'acquisition

Connectez-vous en tant gu'administrateur ou membre de ce groupe.
Ouvrez une invite de commande et entrez les commandes suivantes :
REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\LanmanServer\Parameters" /f

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\LanmanServer\Parameters" /v RequireSecuritySignature /t REG_DWORD /d 1 /f
Fermez l'invite de commande.

FACULTATIF - Désinstallation de CodeMeter

Suivez les instructions ci-dessous pour désinstaller CodeMeter sur les systemes d'acquisition 6.9.6 R2 et 6.9.6 R3 et les postes de travail d'examen uniquement.

uE W
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1) Notez les exigences de connexion suivantes :
e Surles systemes d'acquisition autonomes, vous devez étre connecté en tant que membre du groupe administrateur local @ Windows et Custom Shell.
e Surles systemes d'acquisition en réseau, les postes de travail d'examen, vous devez étre connecté en tant que membre du groupe administrateur de

domaine a Windows et Custom Shell.

2) Cliquez sur Start > Control Panel > Programs and Features (Démarrer > Panneau de configuration > Programmes et fonctionnalités).

3) Sélectionnez CodeMeter Runtime Kit Reduced v5.00 et cliquez sur Uninstall (Désinstaller).

4) Cliquez sur Yes (Oui).

5) Cliquez sur OK.

6) Cliquez sur Start > Control Panel > Windows Firewall > Advanced settings (Démarrer > Panneau de configuration > Pare-feu Windows > Parametres avancés).

7) Dans le volet de gauche, cliquez sur Inbound Rules (Regles de trafic entrant).

8) Dans le volet de droite, faites un clic droit sur chaque entrée CodeMeter Runtime Server I'une apres I'autre et sélectionnez Delete (Supprimer).

9) Cliquez sur Yes (Oui).

10) Dans le volet de gauche, cliquez sur Outbound Rules (Regles de trafic sortant).

11) Dans le volet de droite, assurez-vous que les entrées CodeMeter Runtime Server ne sont pas visibles.

12) Fermez toutes les fenétres ouvertes et redémarrez le systeme.

FACULTATIF - Nettoyage du disque dur

Suivez les instructions ci-dessous pour nettoyer le disque C: sur les postes de travail d'examen 6.9.6 R3 et revue virtuelle uniqguement. Les instructions suivantes
s'‘appliquent uniguement aux systemes MLCL créeés avec l'ancienne image et ne s'appliquent pas aux systemes MLCL créés avec la nouvelle image. Reportez-vous a la
section MLCL V6.9.6 2018 Mises @ jour de correctif 7 concernant la différence entre I'ancienne et la nouvelle image.

1) Notez les exigences de connexion suivantes :
e Surles systemes des postes de travail d'examen et revue virtuelle, vous devez étre connecté en tant que membre du groupe administrateur de domaine a
Windows et Custom Shell.
2) Ouvrez Windows Explorer.
3) Cliquez sur Organize > Folder and search options > View (Organiser > Options des dossiers et de recherche > Afficher).
4) Sélectionnez Show hidden files, folders, and drivers (Afficher les fichiers, dossiers et disques cachés).
5) Désélectionnez Hide protected operating system files (Recommended) (Masquer les fichiers protégés du systeme d'exploitation (recommandé)).
6) Sivous y étes invité, cliquez sur Yes (Oui.
7) Cliquez sur OK.
8) Supprimez définitivement le contenu des dossiers suivants s'ils existent ; si vous y étes invité, cliquez sur Continue (Continuer) :
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C:\Windows\SoftwareDistribution\Download
C:\Users\MLCLLogonUser\AppData\Local\Temp
C:\Users\MLCLLogonUser.<domainname>\AppData\Local\Temp
C:\Users\MLCLTechUser\AppData\Local\Temp
C:\Users\MLCLTechUser.<domainname>\AppData\Local\Temp
C:\Users\MLCLUser\AppData\Local\Temp
C:\Users\MLCLUser.<domainname>\AppData\Local\Temp
C\Temp
Remarque : Sur le systeme Examen virtuel, ne supprimez pas C:\Temp\VirtualReviewBanner.reg ni le dossier C:\Temp\Tools.
e C:\Windows\Temp
e C\Windows\Logs
e C\Windows\Installer\$PatchCache$\Managed
9) Cliquez sur Organize > Folder and search options > View (Organiser > Options des dossiers et de recherche > Afficher).
10) Sélectionnez Don’t show hidden files, folders, or drivers (Ne pas afficher les fichiers, dossiers et disques cachés).
11) Sélectionnez Hide protected operating system files (Recommended) (Masquer les fichiers protégés du systeme d'exploitation (recommandé)).
12) Cliquez sur OK.
13) Faites un clic droit sur Computer (Ordinateur) et sélectionnez Manage (Gérer).
14) Développez et cliquez sur Storage > Disk Management (Stockage > Gestion des disques).
15) Faites un clic droit sur la partition C: et sélectionnez Properties (Propriétés).
16) Cliquez sur Tools > Defragment now (Outils > Défragmenter maintenant).
17) Sélectionnez la partition C: et cliquez sur Defragment disk (Défragmenter le disque).
18) Attendez que la défragmentation se termine.
19) Fermez la fenétre du défragmenteur de disque.
20) Fermez C: Fenétre Propriétés.
21) Ouvrez Windows Explorer.
22) Faites un clic droit sur C: Disque dur
23) Cliquez sur Properties > Disk Cleanup > Clean up system files (Propriétés > Nettoyage du disque > Nettoyer les fichiers systeme).
24) Sivous y étes invité, cliquez sur Yes (Oui).
25) La section Fichiers a supprimer contient des cases a cocher. Cochez toutes les cases, assurez-vous qu'elles soient toutes cochées.
26) Cliquez sur le bouton OK.
27) Si l'invite « Etes-vous sar de vouloir supprimer définitivement ces fichiers ? » s'affiche, cliquez sur le bouton Delete Files (Supprimer les fichiers).
28) Une fois le processus de nettoyage du disque terminé, redémarrez le systéme.
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FACULTATIF - Supprimer les utilisateurs authentifiés d'un partage sur le serveur INW
Conditions préalables :

1.
2.

Les utilisateurs authentifiés sur les systemes INW doivent étre supprimés uniquement sur les serveurs INW.
Les utilisateurs authentifiés sur les systémes INW doivent &tre supprimés uniquement sur le répertoire Studies (Etudes) situé dans le chemin
D:\GEData\Studies.
Les groupes de systemes MLCL suivants doivent étre ajoutés aux Autorisations du répertoire D:\GEData\Studies :
a. MCLAAmGrp
b. MCLSystemGrp
c. MCLUsrGrp
d. SYSTEM (serveur membre uniquement)

Procédure de suppression de l'utilisateur authentifié

1. Surle serveur INW, exécutez Windows Explorer.
2. Accédez a D:\GEData.
3. Effectuez un clic droit sur le répertoire Studies (Etudes) et sélectionnez Properties (Propriétés).
4. Sélectionnez I'onglet Sharing (Partage).
5. Cliquez sur le bouton Advanced Sharing (Partage avancé).
6. Cliquez sur le bouton Permissions (Autorisations).
7. Dans la liste Group or user names (Noms de groupe ou d'utilisateur), sélectionnez Authenticated Users (Utilisateurs authentifiés) et cliquez sur
Remove (Supprimer).
8. Cliquez sur Add (Ajouter).
9. Saisissez les noms de groupe suivants, puis cliquez sur OK : MLCLAAmGrp ; MLCLSystemGrp ; MLCLUsrGrp.
10. Dans un environnement de serveur membre uniquement, procédez comme suit :
a. Cliquez sur Add (Ajouter).
b. Cliquez sur Locations (Emplacements), sélectionnez le nom du serveur INW dans I'arborescence Location (Emplacement), puis cliquez sur OK.
c. Saisissez le nom SYSTEM (SYSTEME) puis cliquez sur OK.
11. Sélectionnez le groupe MLCLAAmMGrp et, dans la colonne Allow (Autoriser), cochez la case Change (Modifier).
12. Sélectionnez le groupe MLCLSystemGrp et, dans la colonne Allow (Autoriser), cochez la case Change (Modifier).
13. Sélectionnez le groupe MLCLUsrGrp et, dans la colonne Allow (Autoriser), cochez la case Change (Modifier).
14. Dans un environnement de serveur membre uniquement , procédez comme suit :
a. Sélectionnez le groupe SYSTEM (SYSTEME) et, dans la colonne Allow (Autoriser), cochez la case Change (Modifier).
15. Cliquez sur OK pour fermer la fenétre Permissions (Autorisations).
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16. Cliquez sur OK pour fermer la fenétre Advanced Sharing (Partage avancé).
17. Cliquez sur Close pour fermer la fenétre Properties (Propriétés).
18. Redémarrez le serveur lorsqu'aucun cas n'est en cours.

FACULTATIF - Vulnérabilité de I'exécution a distance du code Remote Desktop Services

Nous recommandons de désactiver le RDS sur tous les systemes ML/CL s'il n'est pas utilisé. Reportez-vous aux instructions ci-dessous pour désactiver le service.

Désactiver Remote Desktop Services sur Windows 7

Sur Windows 7, procédez comme suit pour désactiver Remote Desktop Services :

1.
2.
3.

O o N o !

Effectuez un clic droit sur Computer (Ordinateur) et sélectionnez Properties (Propriétés).

Dans la fenétre System (Systeme), cliquez sur Remote settings (Parametres a distance)

Décochez l'option suivante si elle est cochée :

Allow Remote Assistance connections to this computer (Autoriser les connexions d'assistance a distance a cet ordinateur)

Sélectionnez l'option suivante si elle n'est pas déja sélectionnée :

Don't allow connections to this computer (Ne pas autoriser les connexions a cet ordinateur)

Cliquez sur OK pour fermer la fenétre System Properties (Propriétés du systeme)

Cliquez sur Start > Control Panel > Administrative Tools > Services (Démarrer > Panneau de configuration > Outils d'administration > Services)
Double-cliquez sur l'entrée pour Remote Desktop Services (Services Bureau a distance)

Réglez Startup type (Type de démarrage) sur Disabled (Désactivé)

Cliquez sur OK pour fermer la fenétre Remote Desktop Services Properties (Propriétés des services Bureau a distance)

10. Redémarrez le systéeme
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Désactiver Remote Desktop Services sur Windows 2008 R2

Sur Windows 2008 R2, procédez comme suit pour désactiver Remote Desktop Services :

1.
2.
3.

G N o wu

Effectuez un clic droit sur Computer (Ordinateur) et sélectionnez Properties (Propriétés).
Dans la fenétre System (Systeme), cliquez sur Remote settings (Parametres a distance)

Décochez l'option suivante si elle est cochée :
Allow Remote Assistance connections to this computer (Autoriser les connexions d'assistance a distance a cet ordinateur)

Sélectionnez l'option suivante si elle n'est pas déja sélectionnée :
Don't allow connections to this computer (Ne pas autoriser les connexions a cet ordinateur)

Cliquez sur OK pour fermer la fenétre System Properties (Propriétés du systeme)

Cliquez sur Start > Administrative Tools > Services (Démarrer > Outils d'administration > Services)
Double-cliquez sur I'entrée pour Remote Desktop Services (Services Bureau a distance)

Réglez Startup type (Type de démarrage) sur Disabled (Désactivé)

Cliquez sur OK pour fermer la fenétre Remote Desktop Services Properties (Propriétés des services Bureau a distance)

10. Redémarrez le systeme
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Liens de correctifs

Les correctifs affichés ci-dessous sont qualifiés sur une base indépendante et peuvent étre installés sur une base individuelle, bien qu'il soit recommandé d'installer tous les correctifs. Il
existe des dépendances au sein de la liste de correctifs. Dans le tableau ci-dessous, il est recommandé d'installer les correctifs dans l'ordre (du haut vers le bas) afin de s'assurer que
tous les prérequis sont respectés pour tous les correctifs. A l'occasion, les dépendances de correctifs nécessitent le redémarrage du systeme (indiqué dans le tableau ci-dessous).

REMARQUE : en raison des configurations du site, I'ensemble des correctifs du systeéme, les correctifs qui ont déja été installés ou les dépendances de correctifs, certains correctifs
pourraient ne pas s'installer en raison d'une fonctionnalité déja installée. L'installeur de correctifs Microsoft vous avertit de ce probléme. Si cela se produit, veuillez continuer avec

l'installation de correctif suivante.

Emplacements alternatifs de correctifs : Au début de 2016 Microsoft a annoncé que certains correctifs ne seraient plus disponibles dans le Centre de téléchargement Microsoft
https://blogs.technet.microsoft.com/msrc/2016/04/29/changes-to-security-update-links/ Par conséquent, certains des liens fournis ci-dessous peuvent ne pas fonctionner. Microsoft

peut déplacer/supprimer ces liens a tout moment sans préavis. Cependant, si les liens ne fonctionnent pas, il existe deux autres méthodes pour le téléchargement des correctifs. La
premiére est le catalogue Microsoft http://catalog.update.microsoft.com. La plupart des correctifs qui ne sont pas dans le centre de téléchargement Microsoft sont disponibles & partir

du Catalogue Microsoft. Si un correctif n'est pas disponible dans le catalogue Microsoft, Microsoft dispose de fichiers ISO mensuels de mise a jour de sécurité disponibles a I'adresse
suivante : https://support.microsoft.com/en-us/kb/913086 Pour utiliser les 1SO, déterminez le mois du correctif, téléchargez I'SO applicable et extrayez le correctif. Si aprés avoir

essayé les trois méthodes vous n'obtenez toujours pas de correctif, veuillez contacter le Support Technique GE pour plus d'aide.

Correctifs non qualifiés MLCL v6.9.6 R3

Serveur INW

Acquisition - Mac-Lab IT/XT/XTi,
CardioLab IT/XT/XTi et SpecialsLab

Poste de travail client GE de
consultation

Revue virtuelle

Plate-forme de | Windows Server 2008 R2 SP1
systeme
d'exploitation

Windows 7 SP1

Windows 7 SP1

Windows 7 SP1

Vulnérabilité
non qualifiée
actuelle

KB4462178 (CVE-2019-1034)

KB4462178 (CVE-2019-1034)

KB4462178 (CVE-2019-1034)

MLCL V6.9.6 2017 Mises a jour de correctif 1 (Ne s'applique qu'a lI'ancienne image)
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https://blogs.technet.microsoft.com/msrc/2016/04/29/changes-to-security-update-links/
http://catalog.update.microsoft.com/
https://support.microsoft.com/en-us/kb/913086

Windows 7 (Acquisition, examen et examen virtuel)

KB Lien Remarques

Effectuez le changement de registre suivant

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00023c00

KB2901907 https://www.microsoft.com/en-us/download/details.aspx?id=42642 Faites un clic droit et
sélectionnez Exécuter en tant
gu'administrateur

Adobe 11.0.20 http://supportdownloads.adobe.com/thankyou.jsp?ftplD=6157&filelD=6191

KB4025341 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=12c93ad9-ef0e-4ce6-8a1d-84713223d24a

Rollup juillet 2017

KB4034664 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=e0a94bad-5b2c-4611-9066-24491ce9bbaf Pour installer ce rollup

Rollup aoGt 2017 correctement, vous devez
désinstaller le rollup de juillet

KB4025341 et redémarrer
avant d'installer KB4034664

Redémarrage B

requis

KB4019112 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=1daeb6d1-b103-4baa-bbde-5326e17e89¢e4 Exécutez KB4014514 et
KB4014504 uniquement. Pour
KB4014514, effectuez un clic
droit et exécuter en tant
gu'administrateur,
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https://www.microsoft.com/en-us/download/details.aspx?id=42642
http://supportdownloads.adobe.com/thankyou.jsp?ftpID=6157&fileID=6191
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=12c93ad9-ef0e-4ce6-8a1d-84713223d24a
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=e0a94bad-5b2c-4611-9066-24491ce9bb4f
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=1daeb6d1-b103-4baa-bbde-5326e17e89e4

KB3125869 https://support.microsoft.com/en-us/help/3125869/ms15-124-vulnerability-in-internet-explorer-could-lead-to-aslr-bypass- | Téléchargez et installez
december-16,-2015 uniguement « Enable the

User32 exception handler
hardening feature in Internet
Explorer » (Activer la
fonctionnalité de durcissement
du gestionnaire d’exceptions
de User32 dans Internet
Explorer)

KB2889841 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=bb220b30-6d01-4e57-8db6-3e492d6065d3 )

KB3178688 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=322c28f5-349¢c-4680-0c94-901616f52372

KB3178690 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=06e2c9fb-65b7-48f5-b6e2-58071f17f9bd

KB3178687 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=726adfc6-4ac9-4409-bdab-2892b7058e78

kb3141538 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=6be5e673-e3f6-4c8e-8834-732baf0eb5d3

KB3191847 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=4b4bbe2b-a25d-4509-a069-f5efc227b4ad

KB3191907 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=c8533f11-51f9-4f84-96d8-c619947cc7c0

KB3118310 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=c59albb2-ff1f-427a-a8d7-2cablcb3e7dl

KB3191843 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=f715a081d-102d-416a-9a89-e9ebdace0abd

KB3191899 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=7698c63a-b85f-4647-bcb1-1be0256c3f43
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https://support.microsoft.com/en-us/help/3125869/ms15-124-vulnerability-in-internet-explorer-could-lead-to-aslr-bypass-december-16,-2015
https://support.microsoft.com/en-us/help/3125869/ms15-124-vulnerability-in-internet-explorer-could-lead-to-aslr-bypass-december-16,-2015
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=bb220b30-6d01-4e57-8db6-3e492d6b65d3
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=322c28f5-349c-468a-ac94-901616f52372
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=06e2c9fb-65b7-48f5-b6e2-58071f17f9bd
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=726adfc6-4ac9-4409-bdab-2892b7058e78
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=6be5e673-e3f6-4c8e-8834-732baf0eb5d3
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=4b4bbe2b-a25d-4509-a069-f5efc227b4ad
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=c8533f11-51f9-4f84-96d8-c619947cc7c0
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=c59a1bb2-ff1f-427a-a8d7-2cab1cb3e7d1
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=f715a81d-102d-416a-9a89-e9ebdace0a6d
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=7698c63a-b85f-4647-bcb1-1be0256c3f43

KB3203468 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=7a599998-ca41-4840-90ea-8143724e5c6da Utilisez all-proof-en-us_.....cab
KB3213624 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=3658f96e-a521-429d-a9a9-e70e30f5d830

HPSBHF03557 ftp://ftp.hp.com/pub/softpag/sp80001-80500/sp80050.exe Non applicable pour 'examen
Rév. 1 virtuel.

Mise & jour du https://support.hp.com/us-en/drivers/selfservice/hp-z440-workstation/6978828

BIOS HP z440

KB3118378 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=ae54ce3d-e321-4831-alba-fcae8eb430a0

Redémarrage

requis

Effectuez le changement de registre suivant

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00010000

Windows 2008R2 (INW)

KB

Lien

Effectuez le changement de registre suivant

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00023c00

Adobe 11.0.20

http://supportdownloads.adobe.com/thankyou.jsp?ftplD=6157&filelD=6191
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=7a599998-ca41-4840-90ea-8143724e5c6a
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=3658f96e-a521-429d-a9a9-e70e30f5d830
ftp://ftp.hp.com/pub/softpaq/sp80001-80500/sp80050.exe
https://support.hp.com/us-en/drivers/selfservice/hp-z440-workstation/6978828
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=ae54ce3d-e321-4831-a1ba-fcae8eb430a0
http://supportdownloads.adobe.com/thankyou.jsp?ftpID=6157&fileID=6191

KB3125869 https://support.microsoft.com/en-us/help/3125869/ms15-124-vulnerability-in-internet-explorer-could-lead-to-aslr-bypass- | Téléchargez et installez
december-16,-2015 uniguement « Enable the
User32 exception handler
hardening feature in Internet
Explorer » (Activer la
fonctionnalité de durcissement
du gestionnaire d’exceptions
de User32 dans Internet

Explorer)
KB4025341 https://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=b2423c5b-0254-4747-88bb-ec1a785549¢ch
Rollup juillet 2017
http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=80f7899d-451d-4e3f-b54e-d488a06a3c58 Pour installer ce rollup
KB4034664 correctement, vous devez
Rollup aodit 2017 désinstaller le rollup de juillet

KB4025341 et redémarrer
avant d'installer KB4034664

KB4019112 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=dedea6da-e039-487b-8ec6-2729551f7165 Exécutez KB4014514 et
KB4014504 uniquement. Pour
KB4014514, effectuez un clic
droit et exécuter en tant
qgu'administrateur,

HPSBMUO03653 https://h20566.www?2.hpe.com/hpsc/swd/public/detail?switemId=MTX_083799d6dad34195bb47cb4a3cl
rev.l

Redémarrage

requis

Effectuez le changement de registre suivant

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00010000
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https://support.microsoft.com/en-us/help/3125869/ms15-124-vulnerability-in-internet-explorer-could-lead-to-aslr-bypass-december-16,-2015
https://support.microsoft.com/en-us/help/3125869/ms15-124-vulnerability-in-internet-explorer-could-lead-to-aslr-bypass-december-16,-2015
https://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=b2423c5b-0254-4747-88bb-ec1a785549cb
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=80f7899d-451d-4e3f-b54e-d488a06a3c58
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=dedea6da-e039-487b-8ec6-2729551f7165
https://h20566.www2.hpe.com/hpsc/swd/public/detail?swItemId=MTX_083799d6dad34195bb47cb43c1

[HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\NTDS\Parameters] S'applique uniquement au
controleur de domaine
LdapEnforceChannelBinding=DWORD:1 Démarrage du rollup de
juillet nécessaire :
KB4025341 (CVE-2017-8563)

MLCL V6.9.6 2017 Mises a jour de correctif 2 (Ne s'applique qu'a lI'ancienne image)

Les correctifs suivants actualisent le niveau de correctifs du systéeme MLCL et résolvent plusieurs vulnérabilités de sécurité. Les directives suivantes s'appliquent :

1)
2)
3)
4)
5)

6)

Les correctifs ci-dessus sont des correctifs requis pour 6.9.6 et doivent étre appliqués en premier.

Il est prévu que certains correctifs énumérés seront déja sur le systeme.

Faites attention a la section Notes d'instructions particulieres de manipulation

Les correctifs doivent étre appliqués dans l'ordre, sauf dans les cas indiqués.

Les redémarrages ne sont obligatoires que quand c'est précisé. Si un correctif nécessite un redémarrage a un autre moment, le systeme peut étre redémarré,
mais ce n'est pas nécessaire.

Les correctifs ne s'installent pas si le composant logiciel & corriger n'est pas présent (par exemple un correctif IE8 sur un systéme sur lequel IE8 n'est pas
installé).

Remarque : KB4041681 remplace KB4041678 pour Windows 7 et Windows Server 2008 R2 pour résoudre CVE-2017-11771, CVE-2017-11772, CVE-2017-11780,
CVE-2017-11781

Windows 7 (Acquisition, examen et examen virtuel)

KB

Lien Remarques

Effectuez le changement de registre suivant

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00023c00

Adobe 11.0.23 | http://supportdownloads.adobe.com/thankyou.jsp?ftplD=6279&filelD=6314
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http://supportdownloads.adobe.com/thankyou.jsp?ftpID=6279&fileID=6314

KB4041681 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=8a346e85-6ae3-46aa-a9el-
Octobre 2017 | 2e70e760f61c

Rollup

mensuel

Effectuez le changement de registre suivant

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00010000

Redémarrage requis

Windows 2008R2 (Serveur INW)

KB

Lien

Remarques

Effectuez le changement de registre suivant

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00023c00

Adobe 11.0.23

http://supportdownloads.adobe.com/thankyou.jsp?ftplD=6279&filelD=6314
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=8a346e85-6ae3-46aa-a9e1-2e70e760f61c
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=8a346e85-6ae3-46aa-a9e1-2e70e760f61c
http://supportdownloads.adobe.com/thankyou.jsp?ftpID=6279&fileID=6314

KB84041681
Octobre 2017
Rollup
mensuel

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=cd0388fd-5aca-4a13-8417-

c28e1d8b7dda

Pour installer ce rollup
correctement, vous devez
désinstaller le rollup de juillet
KB4025341,

Rollup d'aoiit KB4034664 et
redémarrer avant d'appliquer
KB4041681

Effectuez le changement suivant dans
le registre. Uniquement sur

Le controleur de domaine s'il n'existe
pas:
[HKEY_LOCAL_MACHINE\System\Curr
entContro
ISet\Services\NTDS\Parameters]
LdapEnforceChannelBinding=DWORD:
1

Cette clé de registre est
nécessaire sur le Contréleur de
domaine démarrant le rollup de
juillet : KB4025341 (CVE-2017-
8563)

Effectuez le changement de registre suivant
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[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00010000

Redémarrage requis
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=cd0388fd-5aca-4a13-8417-c28e1d8b7dda
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=cd0388fd-5aca-4a13-8417-c28e1d8b7dda

MLCL V6.9.6 2018 Mises a jour de correctif 3 (Ne s'applique qu'a lI'ancienne image)

Les correctifs suivants actualisent le niveau de correctifs du systéeme MLCL et résolvent plusieurs vulnérabilités de sécurité. Les directives suivantes s'appliquent :

1) Les correctifs ci-dessus sont des correctifs requis pour 6.9.6 et doivent étre appliqués en premier.

2) Faites attention a la section Notes d'instructions particulieres de manipulation

3) Les correctifs doivent étre appliqués dans l'ordre, sauf dans les cas indiqués.

4) Les redémarrages ne sont obligatoires que quand c'est précisé. Si un correctif nécessite un redémarrage & un autre moment, le systéme peut étre redémarré,
mais ce n'est pas nécessaire.

Procédez comme suit pour effectuer les modifications de registre suivantes afin de corriger les vulnérabilités des rollups
mensuels de juin et septembre.
Référence : https://portal.msrc.microsoft.com/en-us/security-guidance/advisory/CVE-2017-8529

Windows 7 (Acquisition, examen et examen virtuel) et Windows 2008 R2 (serveur INW):

O ~NOULLE WN

Cliquez sur Start (Démarrer), cliquez sur Run (Exécuter), tapez regedt32 ou tapez regedit, puis cliquez sur OK.

Dans I'Editeur de registre, recherchez le dossier de registre suivant : HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet Explorer\Main\FeatureControl\
Effectuez un clic droit sur FeatureControl (Contréle de la fonctionnalité), sélectionnez New (Nouveau), puis cliquez sur Key (CIé).

Tapez FEATURE_ENABLE_PRINT_INFO_DISCLOSURE_FIX, puis appuyez sur Entrée pour nommer la nouvelle sous-clé.

Effectuez un clic droit sur FEATURE_ENABLE_PRINT_INFO_DISCLOSURE_FIX, sélectionnez New (Nouveau), puis cliquez sur DWORD Value (Valeur DWORD).
Tapez « iexplore.exe » pour la nouvelle valeur DWORD.

Double-cliquez sur la nouvelle valeur DWORD nommeée iexplore.exe et définissez le champ de données Value (Valeur) sur 1.

Cliquez sur OK pour fermer.

Windows 2008 R2 (serveur INW):

1.
2.

3.
4.
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Cliquez sur Start (Démarrer), cliquez sur Run (Exécuter), tapez regedt32 ou tapez regedit, puis cliquez sur OK.

Dans |'Editeur de registre, recherchez le dossier de registre suivant :
HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Microsoft\Internet Explorer\Main\FeatureControl\

Effectuez un clic droit sur FeatureControl (Contréle de la fonctionnalité), sélectionnez New (Nouveau), puis cliquez sur Key (Clé).
Tapez FEATURE_ENABLE_PRINT_INFO_DISCAISSON_FIX, puis appuyez sur Entrée pour nommer la nouvelle sous-clé.
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https://portal.msrc.microsoft.com/en-us/security-guidance/advisory/CVE-2017-8529

Effectuez un clic droit sur FEATURE_ENABLE_PRINT_INFO_DISCLOSURE_FIX, sélectionnez New (Nouveaul), puis cliquez sur DWORD Value (Valeur DWORD).
Tapez « iexplore.exe » pour la nouvelle valeur DWORD.

Double-cliquez sur la nouvelle valeur DWORD nommeée iexplore.exe et définissez le champ de données Value (Valeur) sur 1.

Cliquez sur OK pour fermer.

O Now

Windows 7 (Acquisition, examen et examen virtuel)

KB Lien Remarques

Effectuez le changement de registre suivant

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00023c00

KB4048957 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=224b07ab-de98-45f0-8b9¢c-83551cac66f6
Rollup mensuel de
novembre 2017

Redémarrage requis

KBA4054518 http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=5b48d1ch-83f7-43e1-9308-18872ffe4dce
Rollup mensuel de
décembre 2017
Redémarrage requis
KB3203468 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=7a599998-ca41-4840-90ea-
Juillet 2017 8143724e5¢c6a
Microsoft
Office 2010
KB3213626 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=2bb1487f-b287-41a9-b0ec-
Septembre 2017 | 01b42aa4759e
Microsoft
Office 2010
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=224b07ab-de98-45f0-8b9c-83551cac66f6
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=5b48d1cb-83f7-43e1-9308-18872ffe4dce
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=7a599998-ca41-4840-90ea-8143724e5c6a
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=7a599998-ca41-4840-90ea-8143724e5c6a
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=2bb1487f-b287-41a9-b0ec-01b42aa4759e
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=2bb1487f-b287-41a9-b0ec-01b42aa4759e

KB3128027 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=4740a90a-7767-4f4f-b3f5-
Septembre 2017 | 2ffal2feaseb
Microsoft
PowerPoint 2010
KB3141537 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=0c646d3e-697d-4463-a6eq-
Septembre 2017 | afb3493c5cea
Microsoft
Publisher 2010
KB2553338 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=14e73852-cbd2-456a-a9a8- Un message d'erreur peut
Octobre 2017 7f0c10f1fa40 apparaitre (Impossible d'installer
Microsoft Ie_ chemi)ncd'occés de rglise o
. niveau...) Ce message aderreur
Office 2010 5P2 peut étre ignoré. °
KB2837599 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=54ccbc02-879e-4aa1-b817-
Octobre 2017 12418ce8dfcd
Microsoft Office
2010 SP2
KB4011612 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=8230d598-8ab1-4efc-89b6- Un message d'erreur peut
Décembre 2017 | d3507a06dfd20 apparaitre (Impossible d'installer
Microsoft Ig chemi)ncd'occés de r(rjwlise a
. niveadu...) Ce message aerreur
Office 2010 SP2 peut étre ignoré. ’
KB4011660 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=d7594745-04d5-4631-b2d7-
Janvier 2018 289816f4dd43
Microsoft
Excel 2010
KB4011659 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=0b5a1bf0-3043-47fd-afc3-
Janvier 2018 d2fb55a046096
Microsoft
Word 2010
KB4011611 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=3b2c376c-ea57-4925-b81d- Extrayez l'archive vers un

3b765d456f2b

emplacement et exécutez les
fichiers extraits pour installer.
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=474aa90a-7767-4f4f-b3f5-2ffa12fea4e6
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=474aa90a-7767-4f4f-b3f5-2ffa12fea4e6
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=0c646d3e-697d-4463-a6ea-afb3493c5cea
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=0c646d3e-697d-4463-a6ea-afb3493c5cea
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=14e73852-cbd2-456a-a9a8-7f0c10f1fa40
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=14e73852-cbd2-456a-a9a8-7f0c10f1fa40
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=54ccbc02-879e-4aa1-b817-12418ce8dfcd
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=54ccbc02-879e-4aa1-b817-12418ce8dfcd
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=8230d598-8ab1-4efc-89b6-d3507a6dfd20
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=8230d598-8ab1-4efc-89b6-d3507a6dfd20
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=d7594745-04d5-4631-b2d7-289816f4dd43
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=d7594745-04d5-4631-b2d7-289816f4dd43
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=0b5a1bf0-3043-47fd-afc3-d2fb55a46a96
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=0b5a1bf0-3043-47fd-afc3-d2fb55a46a96
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=3b2c376c-ea57-4925-b81d-3b765d456f2b
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=3b2c376c-ea57-4925-b81d-3b765d456f2b

Janvier 2018 Vérifiez que les mises a jour ont
Microsoft été installées avec succeés.
Office 2010 SP2
KB4011610 https://www.microsoft.com/en-us/download/details.aspx?id=56447
Janvier 2018
Microsoft
Office 2010
KB4054172 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=537fc3ba-4248-40b8-9498- Installez KB4054172, KB4019990
Janvier 2018 8a671abebfe9 et KB4054176.
.NET Framework
KB2719662 Créez les clés de registre suivantes
Clé=[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\Windows\Sidebar\]
Nom de valeur=[TurnOffSidebar]
Type=[REG_DWORD]
Donnée=[1]
KB2269637 Créez les clés de registre suivantes
Clé=[ HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\]
Nom de valeur=[CWDlIllegallnDlIISearch]
Type=[REG_DWORD]
Donnée=[1]
Effectuez le changement de registre suivant
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]
State=dword:00010000
Redémarrage requis
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https://www.microsoft.com/en-us/download/details.aspx?id=56447
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=537fc3ba-4248-40b8-9498-8a671abebfe9
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=537fc3ba-4248-40b8-9498-8a671abebfe9

Windows 2008R2 (Serveur INW)

Service Stack

KB4048957
Rollup mensuel
de

novembre 2017

KB4054518
Rollup mensuel
de

Redémarrage requis
http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=435d3006-04ae-4c27-a5f9-3¢c36f09e58ed

Redémarrage requis
http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=09064e30-6f3e-4c99-8d09-fbc2ba06b436

KB Lien Remarques

Effectuez le changement de registre suivant

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software

Publishing]

State=dword:00023c00

http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=f1b99598-a22d-4fbe-9b63-09724833acc3 Nécessaire pour permettre

I'installation du rollup mensuel

KB3177467 sans devoir désinstaller le rollup

mensuel précédent

décembre 2017
Redémarrage requis
KB4054172 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=fdecaf44-50a3-4667-0935-
Janvier 2018 | f9e7afObb317
NET
Framework
KB2269637 Créez les clés de registre suivantes
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=f1b99598-a22d-4fbe-9b63-09724833acc3
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=435d3006-04ae-4c27-a5f9-3c36f09e58ed
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=09064e30-6f3e-4c99-8d09-fbc2ba06b436
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=fdecaf44-50a3-4667-a935-f9e7af0bb317
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=fdecaf44-50a3-4667-a935-f9e7af0bb317

Clé=[ HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\]
Nom de valeur=[CWDlIllegallnDlISearch]

Type=[REG_DWORD]

Donnée=[1]

Effectuez le changement de registre suivant

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00010000

Redémarrage requis

MLCL V6.9.6 2018 Mises a jour de correctif 4 (Ne s'applique qu'da lI'ancienne image)
Les correctifs suivants actualisent le niveau de correctifs du systéeme MLCL et résolvent plusieurs vulnérabilités de sécurité. Les directives suivantes s'appliquent :

1) Les correctifs ci-dessus sont des correctifs requis pour 6.9.6 et doivent étre appliqués en premier.

2) Faites attention a la section Notes d'instructions particulieres de manipulation

3) Les correctifs doivent étre appliqués dans l'ordre, sauf dans les cas indiqués.

4) Lesredémarrages ne sont obligatoires que quand c'est précisé. Si un correctif nécessite un redémarrage a un autre moment, le systéme peut étre redémarré,
mais ce n'est pas nécessaire.

Windows 7 (Acquisition, examen et examen virtuel)

KB Lien Remarques

Effectuez le changement de registre suivant

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust
Providers\Software Publishing]

State=dword:00023c00
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KB4056894 http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=63bb3909-
Rollup mensuel | e5fe-4502-8d59-44f9df52317f
de décembre
2018
Redémarrage requis
KB4091290 http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=c70372c5-
bd6c-48f7-b562-c326bcl327a4
KB4074598 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=651e95ab-
Rollup 6e7c-4eab-9cd2-3cbabd9b76f0
mensuel de
février
Redémarrage requis
KB4099950 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=0872a60d- REMARQUE : Ce correctif doit étre appliqué avant le
3850-4486-8322-9e759802017a rollup mensuel de mars KB4088875. Si vous ne
I'appliquez pas avant le rollup de mars, les
parameétres NIC peuvent étre affectés.
Rollup http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=3ed75c38-
mensuel de 0036-437e-bf4f-574789591e03
mars
KB4088875
Redémarrage requis
KB4096040 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=be3cdb55-
862¢-4362-b015-894e381e0719
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=63bb3909-e5fe-45a2-8d59-44f9df52317f
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=63bb3909-e5fe-45a2-8d59-44f9df52317f
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=c70372c5-bd6c-48f7-b562-c326bc1327a4
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=c70372c5-bd6c-48f7-b562-c326bc1327a4
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=651e95ab-6e7c-4ea6-9cd2-3cbabd9b76f0
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=651e95ab-6e7c-4ea6-9cd2-3cbabd9b76f0
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=0872a60d-385a-4486-8322-9e759802017a
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=0872a60d-385a-4486-8322-9e759802017a
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=3ed75c38-aa36-437e-bf4f-574789591e03
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=3ed75c38-aa36-437e-bf4f-574789591e03
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=be3cdb55-862c-4362-b015-894e381e07f9
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=be3cdb55-862c-4362-b015-894e381e07f9

KB4099467 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=f325deb3-
28fc-45a3-ab7b-5264f801daf6
Redémarrage requis
KB4093118 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=647f49ef-
Rollup 0f0a-49dc-9766-dd255cded1af
mensuel
d'avril
KB4011707 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=969c78ec-
cd6a-4295-ade3-a57ca7f8b3b2
KB3114874 http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=9fae99be-
ddc3-4e37-b3ee-9b631fd50eca
KB3114416 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=da77f81d-
187b-4cae-a750-d64766a7713d
http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=0aa653a1- Installez AMD64_X86-en-sqlserver2008-kb4057114-
1459-44cd-be0b-0fcb77e4ef85 x86_09295f99a2ee7c714f540f3697be0fd4aee7a7bf.exe
Exécutez depuis une invite de commande en tant
gu'administrateur avec la commande suivante :
AMDG64_X86-en-sqlserver2008-kb4057114-
x86_a9295f99a2ee7c¢714f540f3697beOfd4aee7a7bf.exe
JACTION=Patch /INSTANCENAME=MSSQLSERVER
KB4057114 /IGNORESERVICERESTARTSTATE
Redémarrage requis
KB4103718 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=3f4d0c73-
Rollup a177-48cf-a3e7-97d1a94cba87
mensuel de
mai 2018
Redémarrage requis
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=f325deb3-28fc-45a3-ab7b-5264f801daf6
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=f325deb3-28fc-45a3-ab7b-5264f801daf6
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=647f49ef-0f0a-49dc-9766-dd255cded1af
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=647f49ef-0f0a-49dc-9766-dd255cded1af
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=969c78ec-cd6a-4295-ade3-a57ca7f8b3b2
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=969c78ec-cd6a-4295-ade3-a57ca7f8b3b2
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=9fae99be-ddc3-4e37-b3ee-9b631fd50eca
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=9fae99be-ddc3-4e37-b3ee-9b631fd50eca
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=da77f81d-187b-4cae-a75a-d64766a7713d
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=da77f81d-187b-4cae-a75a-d64766a7713d
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=0aa653a1-1459-44cd-be0b-0fcb77e4ef85
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=0aa653a1-1459-44cd-be0b-0fcb77e4ef85
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=3f4d0c73-a177-48cf-a3e7-97d1a94cba87
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=3f4d0c73-a177-48cf-a3e7-97d1a94cba87

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=d000d6a2-

3321-4381-9024-3345b2cd0435

KB4099633 est le numéro de KB a utiliser pour
télécharger et installer le correctif pour KB4095874
et KB4096495. Le fichier téléchargé contient
plusieurs KB. Suivez les étapes d'installation
suivantes :

1) Installez KB4019990 (un message

KB4095874 indiquant que ce KB est déja installé peut
.NET 3.5SP1 et s'afficher, ignorez-le et continuez)
KB4096495 2) KB4095874
.NET 4.5.2 3) KB4096495
Redémarrage requis
KB4022146 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=5795d737- KB4022146
Microsoft 4091-4784-0707-007b99d3daef Microsoft Excel 2010
Excel 2010
KB2899590 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=d8acdbaf- KB2899590
Microsoft 7f56-4c65-0898-9fdfc7a2d83a Microsoft Office 2010
Office 2010
Effectuez le changement de registre suivant
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust
Providers\Software Publishing]
State=dword:00010000
Redémarrage requis
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=d000d6a2-3321-4381-9a24-3345b2cd0435
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=d000d6a2-3321-4381-9a24-3345b2cd0435
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=5795d737-4091-4784-a707-007b99d3daef
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=5795d737-4091-4784-a707-007b99d3daef
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=d8acdbaf-7f56-4c65-a898-9fdfc7a2d83a
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=d8acdbaf-7f56-4c65-a898-9fdfc7a2d83a

Windows 2008R2 (Serveur INW)

KB

Lien

Remarques

Effectuez le changement de registre suivant

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00023c00

Mise a jour du

https://support.hpe.com/hpsc/swd/public/detail?switemId=MTX_116f29414b06465c96e6bd94ae

micrologiciel Reportez-vous aux « Instructions
CP034882 pour de mise a jour de ML350 Gen9
le serveur BIOS vers v2.56 » ci-dessus pour
ML350 Gen 9 les instructions d'installation
Redémarrage requis
KB4056894 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=fc887fd2-cd35-434b-b6e3-1fef99b2e7ce
Rollup
mensuel de
janvier 2018
Redémarrage requis
KB4091290 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=c96d43ea-477f-47a1-919f-
6936c8d628a3
KB4074598 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=f3ab18cb-219e-4287-b1l4c-
Rollup 3005¢8d9479a
mensuel de
février
Redémarrage requis
KB4099950 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=38b41383-c716-488c-0937- REMARQUE : Ce correctif doit
163bf04f6956 étre appliqué avant le rollup
mensuel de mars KB4088875. Si
vous ne l'appliquez pas avant le
rollup de mars, les parameétres
NIC peuvent étre affectés.
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https://support.hpe.com/hpsc/swd/public/detail?swItemId=MTX_116f29414b06465c96e6bd94ae
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=fc887fd2-cd35-434b-b6e3-1fef99b2e7ce
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=c96d43ea-477f-47a1-919f-6936c8d628a3
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=c96d43ea-477f-47a1-919f-6936c8d628a3
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=f3ab18cb-219e-4287-b14c-3a05c8d9479a
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=f3ab18cb-219e-4287-b14c-3a05c8d9479a
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=38b41383-c716-488c-a937-163bf04f6956
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=38b41383-c716-488c-a937-163bf04f6956

http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=3af42ab1-13ed-42b5-9e4e-

KB4096040 a84la7le7f2c
Rollup http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=03df6731-e0a6-4917-9da3-
mensuel de 161a0b7f6b09
mars
KB4088875
http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=38800bcc-c954-4822-b864-
KB4099467 60e91cc19bb2
Redémarrage requis
KB4093118 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=d2c7363c-323f-4e92-892a-
Rollup 90b83027e4aa
mensuel
d'avril
Redémarrage requis
http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=0aa653a1-1459-44cd-beQb- Installez le fichier AMD64-en-
0fcb77e4ef85 sqlserver2008-kb4057114-
x64_9ce0b7c5909d8fcc5b9al2d1
7f29b7864a9df33a.exe. Exécutez
depuis une invite de commande
en tant qu'administrateur avec la
commande suivante : AMD64-en-
sqlserver2008-kb4057114-
x64_9ce0b7c5909d8fcc5b9al2d1
7f29b7864a9df33a.exe
/ACTION=Patch
J/INSTANCENAME=MSSQLSERVER
KB4057114 /IGNORESERVICERESTARTSTATE
Redémarrage requis
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=3af42ab1-13ed-42b5-9e4e-a841a71e7f2c
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=3af42ab1-13ed-42b5-9e4e-a841a71e7f2c
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=03df6731-e0a6-4917-9da3-161a0b7f6b09
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=03df6731-e0a6-4917-9da3-161a0b7f6b09
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=38800bcc-c954-4822-b864-6ae91cc19bb2
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=38800bcc-c954-4822-b864-6ae91cc19bb2
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=d2c7363c-323f-4e92-892a-90b83027e4aa
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=d2c7363c-323f-4e92-892a-90b83027e4aa
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=0aa653a1-1459-44cd-be0b-0fcb77e4ef85
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=0aa653a1-1459-44cd-be0b-0fcb77e4ef85

KB4103718 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=4fe75106-a2ba-4186-aecd-10424a19225e
Rollup
mensuel de
mai 2018
Redémarrage requis
http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=62ccd808-b5a5-4be9-8a38- KB4099633 est le numéro de KB a
8e20829e29d1 utiliser pour télécharger et
installer le correctif pour
KB4095874 et KB4096495. Le
fichier téléchargé contient
plusieurs KB. Suivez les étapes
d'installation suivantes :
1) Installez KB4019990
(un message indiquant
que ce KB est déja
KB4095874 installé peut s'afficher,
.NET 3.5SP1 et ignorez-le et continuez)
KB4096495 2) KB4095874
.NET 4.5.2 3) KB4096495
Effectuez le changement de registre suivant
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]
State=dword:00010000

Redémarrage requis

MLCL V6.9.6 2018 Mises a jour de correctif 5 (Ne s'applique qu'a lI'ancienne image)

Les correctifs suivants actualisent le niveau de correctifs du systéeme MLCL et résolvent plusieurs vulnérabilités de sécurité. Les directives suivantes s'appliquent :
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=4fe75106-a2ba-4186-aecd-10424a19225e
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=62ccd808-b5a5-4be9-8a38-8e2a829e29d1
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=62ccd808-b5a5-4be9-8a38-8e2a829e29d1

1) Les correctifs ci-dessus sont des correctifs requis pour 6.9.6 et doivent étre appliqués en premier.
2) Faites attention a la section Notes d'instructions particulieres de manipulation
3) Les correctifs doivent étre appliqués dans l'ordre, sauf dans les cas indiqués.

4) Les redémarrages ne sont obligatoires que quand c'est précisé. Si un correctif nécessite un redémarrage @ un autre moment, le systéme peut étre redémarré,
mais ce n'est pas nécessaire.

Windows 7 (Acquisition, examen et examen virtuel)

KB

Lien

Remarques

Effectuez le changement de registre suivant

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00023c00

Mise a jour de
2440 BIOS vers
v2.45

https://support.hp.com/us-en/drivers/selfservice/hp-z440-workstation/6978828

Redémarrage requis

KB4284826
Rollup mensuel
de juin 2018

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=326a09830-3983-402d-b48b-
7035f99c516a

Redémarrage requis

KB4338818
Rollup mensuel
de juillet 2018

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=ea409dca-1368-48cf-94c1-
d510b1690d74

Redémarrage requis

KB4338821

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=dafd8f28-09a9-4d17-8a6c-
9334108379ec

Redémarrage requis
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https://support.hp.com/us-en/drivers/selfservice/hp-z440-workstation/6978828
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=326a9830-3983-402d-b48b-7a35f99c516a
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=326a9830-3983-402d-b48b-7a35f99c516a
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=ea409dca-1368-48cf-94c1-d510b1690d74
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=ea409dca-1368-48cf-94c1-d510b1690d74
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=dafd8f28-09a9-4d17-8a6c-93341a8379ec
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=dafd8f28-09a9-4d17-8a6c-93341a8379ec

KB4343900
Rollup mensuel
d'aoit 2018

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=d785f6dd-d90b-4cb9-838a-
8faf5971165f

Redémarrage requis

KB4343894
IE11

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=3fc3f78a-19¢5-45bc-9f06-
6al4cec0f007

Redémarrage requis

KB4457144
Rollup mensuel
de

septembre 2018

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=f5c88de4-720e-4ed1-b95f-
6ce4d4d06087

Redémarrage requis

KB4345590
.NET Framework

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=08968031-142d-4dcb-9fd8-
29fbd6ae9960

Installez d'abord KB4344149
(redémarrez si vous y étes invité),
puis KB4344152

Redémarrage requis

KB3203468 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=7a599998-ca41-4840-90ea-
Microsoft Office | 8143724e5c6a

Proof 2010 SP2

KB4032223 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=cd28cdbb-b3c2-4266-b417-

Microsoft Excel
2010

d26d53f7d75f

KB4227175
Microsoft Excel
2010

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=bba3a281-f10f-45bc-adf8-
9e4436d4c39b
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=d785f6dd-d90b-4cb9-838a-8faf5971165f
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=d785f6dd-d90b-4cb9-838a-8faf5971165f
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=3fc3f78a-19c5-45bc-9f06-6a14cec0f007
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=3fc3f78a-19c5-45bc-9f06-6a14cec0f007
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=f5c88de4-720e-4ed1-b95f-6ce4d4d06087
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=f5c88de4-720e-4ed1-b95f-6ce4d4d06087
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=08968031-142d-4dcb-9fd8-29fbd6ae9960
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=08968031-142d-4dcb-9fd8-29fbd6ae9960
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=7a599998-ca41-4840-90ea-8143724e5c6a
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=7a599998-ca41-4840-90ea-8143724e5c6a
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=cd28cd6b-b3c2-4266-b417-d26d53f7d75f
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=cd28cd6b-b3c2-4266-b417-d26d53f7d75f
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=bba3a281-f10f-45bc-adf8-9e4436d4c39b
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=bba3a281-f10f-45bc-adf8-9e4436d4c39b

KB4018311 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=f96028c5-b20a-4106-9963-
Microsoft 83261d690a62

Office 2010 SP2

KB3213636 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=7e7049e7-b870-4c87-af60-
Microsoft Office | bc5a0bace002

2010 SP2

KB4022198 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=cc4958f4-308d-474c-a655-
Microsoft Office | 567e41cf9bld

2010 SP2

KB3115197 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=393d97f5-b447-43c5-9e0c-
Microsoft Office | b6707c8d29ce

2010 SP2

KB3115248 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=4cc02a6f-9551-4909-bcel-
Microsoft Office | 4045d41404ec

2010 SP2

KB4022199 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=3f3c71ef-c743-4824-8951-
Microsoft Office | deb8cdabf2eb

2010 SP2

KB4022137 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=9d64be86-d3f2-47a4-a9a3-
Microsoft Office | f8ae05842ed3

2010 SP2

KB4018310 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=4cc49d2c-fe7e-4a55-987e-
Microsoft 4bld4ccb8elc

PowerPoint 2010

KB4011186 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=4564150c-2ab1-42e4-a135-
Microsoft 105b924dc45d

Publisher 2010

KB4022202 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=59253783-0245-4897-993e-
Microsoft 5702ed30c0e0

Word 2010
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=f96028c5-b20a-41a6-9963-83261d690a62
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=f96028c5-b20a-41a6-9963-83261d690a62
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=7e7049e7-b870-4c87-af60-bc5a0bace002
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=7e7049e7-b870-4c87-af60-bc5a0bace002
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=cc4958f4-308d-474c-a655-567e41cf9b1d
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=cc4958f4-308d-474c-a655-567e41cf9b1d
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=393d97f5-b447-43c5-9e0c-b6707c8d29ce
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=393d97f5-b447-43c5-9e0c-b6707c8d29ce
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=4cc02a6f-9551-4909-bce1-4a45d41404ec
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=4cc02a6f-9551-4909-bce1-4a45d41404ec
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=3f3c71ef-c743-4824-8951-deb8cdabf2eb
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=3f3c71ef-c743-4824-8951-deb8cdabf2eb
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=9d64be86-d3f2-47a4-a9a3-f8ae05842ed3
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=9d64be86-d3f2-47a4-a9a3-f8ae05842ed3
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=4cc49d2c-fe7e-4a55-987e-4b1d4ccb8e1c
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=4cc49d2c-fe7e-4a55-987e-4b1d4ccb8e1c
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=4564150c-2ab1-42e4-a135-105b924dc45d
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=4564150c-2ab1-42e4-a135-105b924dc45d
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=59253783-a245-4897-993e-57a2ed30c0e0
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=59253783-a245-4897-993e-57a2ed30c0e0

KB4011674
Microsoft Word
2010

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=b13107b6-02b9-4f00-a6d9-
3bf4a4a3cl2a?

KB4022141
Microsoft Word
2010

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=d2f428f2-7c02-4049-8680-
4407404¢cb70?2

Effectuez le changement de registre suivant

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00010000

Redémarrage requis

Windows 2008R2 (Serveur INW)

KB Lien Remarques
Effectuez le changement de registre suivant
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]
State=dword:00023c00
HPESBHF03874 | https://support.hpe.com/hpsc/swd/public/detail?sp4ts.oid=10094837318&switemld=MTX_2fadlbbda82e4d5ca06
rev.1 ML350 73a1b43&swEnvOid=4184 Reportez-vous aux instructions de
Gen9 mise a jour de Gen9 BIOS vers la
(CP035797) version du 21/5/2018 ci-dessus
Redémarrage requis
Page 46 sur 80

GE Healthcare/18 octobre 2019



http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=b13107b6-02b9-4f00-a6d9-3bf44a3c1247
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=b13107b6-02b9-4f00-a6d9-3bf44a3c1247
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=d2f428f2-7c02-4a49-8680-4407404cb7a2
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=d2f428f2-7c02-4a49-8680-4407404cb7a2
https://support.hpe.com/hpsc/swd/public/detail?sp4ts.oid=1009483731&swItemId=MTX_2fad1bbda82e4d5ca0673a1b43&swEnvOid=4184
https://support.hpe.com/hpsc/swd/public/detail?sp4ts.oid=1009483731&swItemId=MTX_2fad1bbda82e4d5ca0673a1b43&swEnvOid=4184

KB4284826 http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=999fa80e-c59d-4ff6-8268-
Rollup c6a8c365f428
mensuel de
juin 2018
Redémarrage requis
KB4338818 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=1c930eab-7b7e-4616-b5b5-
Rollup d6e4a723bc71
mensuel de
juillet 2018
Redémarrage requis
http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=8e951203-5d8e-4f69-9560-
KB4338821 ce698c4f7a77
Redémarrage requis
KB4343900 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=71600c77-2a56-4ba2-991b- Créez les parameétres de registre
Rollup mensuel | ad477cfc9eb9 suivants s'ils n'existent pas :
d'aolt 2018 Clé=[HKEY_LOCAL_MACHINE\
SYSTEM\CurrentControlSet\Con
trol\Session Manager\
Memory Management]
Nom de valeur=
[FeatureSettingsOverride]
Type=[REG_DWORD]
Donnée=[0]
Clé=[HKEY_LOCAL_MACHINE\SY
STEM\CurrentControlSet\Contr
ol\Session Manager\
Memory Management]
Nom de valeur=
[FeatureSettingsOverrideMask]
Type=[REG_DWORD]
Donnée=(3]
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=999fa80e-c59d-4ff6-8268-c6a8c365f428
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=999fa80e-c59d-4ff6-8268-c6a8c365f428
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=1c930eab-7b7e-4616-b5b5-d6e4a723bc71
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=1c930eab-7b7e-4616-b5b5-d6e4a723bc71
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=8e951203-5d8e-4f69-9560-ce698c4f7a77
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=8e951203-5d8e-4f69-9560-ce698c4f7a77
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=71600c77-2a56-4ba2-991b-ad477cfc9eb9
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=71600c77-2a56-4ba2-991b-ad477cfc9eb9

Redémarrage requis

KB4343894
IE11

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=6525d333-fafc-4345-ad06-
6edc8db84aaf

Redémarrage requis

KB4457144
Rollup mensuel
de

septembre 201
8

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=2986185e-cd31-4f1d-99a5-
beabbdlef53c

Redémarrage requis

KB4345590
NET
Framework

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=14afae30-094f-4dca-ba5f-
e22347edb98f

Installez d'abord KB4344149
(redémarrez si vous y étes invité),
puis KB4344152

Effectuez le changement de registre suivant

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00010000

Redémarrage requis

MLCL V6.9.6 2019 Mises a jour de correctif 6 (Ne s'applique qu'a lI'ancienne image)

Les correctifs suivants actualisent le niveau de correctifs du systéeme MLCL et résolvent plusieurs vulnérabilités de sécurité. Les directives suivantes s'appliquent :

1) Les correctifs ci-dessus sont des correctifs requis pour 6.9.6 et doivent étre appliqués en premier.
REMARQUE : Si une nouvelle image du systeme a été créée a l'aide de la nouvelle image corrigée, n'appliquez alors que les mises d jour de correctif 7 ci-

dessous

1) Faites attention & la section Notes d'instructions particulieres de manipulation
2) Les correctifs doivent étre appliqués dans I'ordre, sauf dans les cas indiqués.
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=6525d333-fafc-4345-ad06-6edc8db84aaf
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=6525d333-fafc-4345-ad06-6edc8db84aaf
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=2986185e-cd31-4f1d-99a5-bea6bd1ef53c
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=14afae30-094f-4dca-ba5f-e22347edb98f
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=14afae30-094f-4dca-ba5f-e22347edb98f

3) Lesredémarrages ne sont obligatoires que quand c'est précisé. Si un correctif nécessite un redémarrage a un autre moment, le systéme peut étre redémarré,
mais ce n'est pas nécessaire.

Installation et configuration de Adobe Reader DC MUI

Suivez les instructions ci-dessous pour installer et configurer Adobe Reader DC MUI sur le systeme d'acquisition 6.9.6 R3, le poste de travail d'examen et le serveur
INW.

Emplacements du programme d'installation de Adobe Reader DC MUI et du téléchargement du correctif :
- Programme d'installation MUI :
o Emplacement : ftp://ftp.adobe.com/pub/adobe/reader/win/AcrobatDC/1500720033/
o Nom du fichier : AcroRdrDC1500720033_MUl.exe

- Correctif (mise a jour Adobe Acrobat Reader MUI DC (Continuous Track) update - Toutes les langues) :
o Emplacement : https://supportdownloads.adobe.com/detail.jsp?ftplD=6523

Remarque : la version V2019.008.20081 du correctif Adobe Reader DC est testée et qualifiée pour l'installation.
Instructions d'installation du programme d'installation de Adobe Reader DC MUI et du correctif :
Remarque : Adobe Reader DC désinstalle automatiquement la version précédente d'’Adobe Reader Xl lors de l'installation.

1) Notez les exigences de connexion suivantes :
e Surles systemes d'acquisition autonomes, vous devez étre connecté en tant que membre du groupe administrateur local d Windows et Custom Shell.
e Surles systemes d'acquisition en réseau, les postes de travail d'examen, vous devez étre connecté
en tant que membre du groupe administrateur de domaine a Windows et Custom Shell.
e Surle serveur INW, vous devez étre connecté en tant que membre du groupe administrateur de domaine & Windows.
2) Accédez a l'emplacement du programme d'installation Adobe, effectuez un clic droit sur AcroRdrbC1500720033_MUl.exe et sélectionnez Run as
Administrator (Exécuter en tant qu'administrateur).
3) Attendez que I'extraction du fichier soit terminée.
4) Conservez I'emplacement du dossier par défaut et cliquez sur Install (Installer).
5) Attendez que l'installation soit terminée.
6) Cliquez sur Finish (Terminer).
7) Accédez a I'emplacement du correctif adobe, double-cliquez sur AcroRdrDCUpd1900820081_MUI.msp.
8) Cliquez sur Update (Mettre a jour).
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9) Attendez que l'installation du correctif soit terminée.
10) Cliquez sur Finish (Terminer).
11) Redémarrez le systeme.

Configuration de Adobe Reader DC MUI :
Adobe Reader DC doit étre configuré sous les utilisateurs Windows suivants dans |'ordre :
o Postes de travail :
= MLCLLogonUser
= MLCLTechUser
o Serveur:
» Administrateur
» MLCLTechUser
MLCLLogonUser :
1) Notez les exigences de connexion suivantes :
e Surles systemes d'acquisition autonomes, vous devez étre connecté en tant que local MLCLLogonUser a Windows et local MLCLUser a Custom Shell.
e Surles systemes d'acquisition en réseau, les postes de travail d'examen, vous devez étre connecté
en tant que domain MLCLLogonUser ¢ Windows et domain MLCLUser & Custom Shell.
2) Cliquez sur Start > All Programs > Acrobat Reader DC (Démarrer > Tous les programmes > Acrobat Reader DC).
3) Dans la fenétre du contrat de licence, cliqguez sur Accept (Accepter).
4) Fermez la fenétre de bienvenue.
5) Cliquez sur Edit > Preferences > General (Editer > Préférences > Général).
6) Désélectionnez Show me messages when | launch Adobe Acrobat Reader (Afficher les messages lorsque je lance Adobe Acrobat Reader).
7) Cliquez sur Internet.
8) Désélectionnez Allow Speculative downloading in the background (Autoriser le téléchargement spéculatif en arriere-plan).
9) Cliquez sur Reviewing (Examen).
10) Cliquez sur Tracker (Outil de suivi.
11) Désélectionnez Show notification icon in system tray (Afficher l'icGne de notification dans la barre d'état du systeme).
12) Cliquez sur OK.
13) Cliquez sur Edit > Preferences > Reviewing (Editer > Préférences > Examen).
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14) Désélectionnez Show Welcome dialog when opening file (Afficher la fenétre de bienvenue a l'ouverture du fichier).
15) Désélectionnez Show server connection warning dialog when opening file (Afficher I'avertissement de connexion au serveur lors de |'ouverture du fichier).
16) Cliquez sur OK.

17) Fermez Adobe Reader DC.

18) Accédez au dossier C:\Program Files\GE Healthcare\MLCL\Doc.

19) Ouvrez Mac-Lab Operator's Manual.pdf.

20) Cliquez sur Edit > Preferences > Documents (Editer > Préférences > Documents).

21) Sélectionnez Remember current state of the Tools pane (Mémoriser I'état actuel du volet Outils).

22) Cliquez sur OK.

23) Cliquez sur View > Show/Hide (Affichage > Afficher/Masquer) et désélectionnez Tools Pane (Volet Outils).

24) Fermez Adobe Reader DC.

25) Le cas échéant, supprimez le raccourci Acrobat Reader DC du bureau.

26) Cliquez sur Continue (Continuer).

27) Entrez le nom d'utilisateur de I'administrateur et le mot de passe, et cliquez sur Yes (Oui).

MLCLTechUser :
1) Notez les exigences de connexion suivantes :
e Surles systemes d'acquisition autonomes, vous devez étre connecté en tant que local MLCLTechUser a Windows et Custom Shell.
e Surles systemes d'acquisition en réseau, les postes de travail d'examen, vous devez étre connecté
en tant que domain MLCLTechUser a Windows et Custom Shell.
e Surle serveur INW, vous devez étre connecté en tant que domain MLCLTechUser & Windows.
2) Cliquez sur Start > All Programs > Acrobat Reader DC (Démarrer > Tous les programmes > Acrobat Reader DC).
3) Fermezla fenétre de bienvenue.
4) Cliquez sur Edit > Preferences > General (Editer > Préférences > Général).
5) Désélectionnez Show me messages when | launch Adobe Acrobat Reader (Afficher les messages lorsque je lance Adobe Acrobat Reader).
6) Cliquez sur Internet.
7) Désélectionnez Allow Speculative downloading in the background (Autoriser le téléchargement spéculatif en arriere-plan).
8) Cliquez sur Reviewing (examen).
9) Cliquez sur Tracker (Outil de suivi).
10) Désélectionnez Show notification icon in system tray (Afficher I'icone de notification dans la barre d'état du systeme).
11) Cliquez sur OK.
12) Cliquez sur Edit > Preferences > Reviewing (Editer > Préférences > Examen).
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13) Désélectionnez Show Welcome dialog when opening file (Afficher la fenétre de bienvenue a l'ouverture du fichier).

14) Désélectionnez Show server connection warning dialog when opening file (Afficher I'avertissement de connexion au serveur lors de l'ouverture du fichier).

15) Cliquez sur OK.

16) Fermez Adobe Reader DC.

17) Accédez au dossier C:\Program Files\GE Healthcare\MLCL\Doc sur les postes de travail et au dossier C:\Program Files (x86)\GE Healthcare\MLCL\Doc sur le
serveur.

18) Ouvrez Mac-Lab Operator's Manual.pdf.

19) Cliquez sur Edit > Preferences > Documents (Editer > Préférences > Documents).

20) Sélectionnez Remember current state of the Tools pane (Mémoriser I'état actuel du volet Outils).

21) Cliquez sur OK.

22) Cliquez sur View > Show/Hide (Affichage > Afficher/Masquer) et désélectionnez Tools Pane (Volet Outils).

23) Fermez Adobe Reader DC.

24) Le cas échéant, supprimez le raccourci Acrobat Reader DC du bureau.

Administrateur :
1) Notez les exigences de connexion suivantes :
e Surle serveur INW, vous devez étre connecté en tant que domain Administrator d Windows.
2) Cliquez sur Start > All Programs > Acrobat Reader DC (Démarrer > Tous les programmes > Acrobat Reader DC).
3) Fermez la fenétre de bienvenue.
4) Cliquez sur Edit > Preferences > General (Editer > Préférences > Général).
5) Désélectionnez Show me messages when | launch Adobe Acrobat Reader (Afficher les messages lorsque je lance Adobe Acrobat Reader).
6) Cliquez sur Internet.
7) Désélectionnez Allow Speculative downloading in the background (Autoriser le téléchargement spéculatif en arriére-plan).
8) Cliquez sur Reviewing (examen).
9) Cliquez sur Tracker (Outil de suivi).
10) Désélectionnez Show notification icon in system tray (Afficher I'icone de notification dans la barre d’état du systeme).
11) Cliquez sur OK.
12) Cliquez sur Edit > Preferences > Reviewing (Editer > Préférences > Examen).
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13) Désélectionnez Show Welcome dialog when opening file (Afficher la fenétre de bienvenue a l'ouverture du fichier).

14) Désélectionnez Show server connection warning dialog when opening file (Afficher I'avertissement de connexion au serveur lors de |'ouverture du fichier).

15) Cliquez sur OK.

16) Fermez Adobe Reader DC.

17) Accédez au dossier C:\Program Files\GE Healthcare\MLCL\Doc sur les postes de travail et au dossier C:\Program Files (x86)\GE Healthcare\MLCL\Doc sur le
serveur.

18) Ouvrez Mac-Lab Operator's Manual.pdf.

19) Cliquez sur Edit > Preferences > Documents (Editer > Préférences > Documents).

20) Sélectionnez Remember current state of the Tools pane (Mémoriser I'état actuel du volet Outils).

21) Cliquez sur OK.

22) Cliquez sur View > Show/Hide (Affichage > Afficher/Masquer) et désélectionnez Tools Pane (Volet Outils).

23) Fermez Adobe Reader DC.

24) Le cas échéant, supprimez le raccourci Acrobat Reader DC du bureau.

Désactivez le service de mise a jour de Adobe Reader :

1) Notez les exigences de connexion suivantes :
e Surles systemes d'acquisition autonomes, vous devez étre connecté en tant que membre du groupe administrateur local d Windows et Custom Shell.
e Surles systemes d'acquisition en réseau, les postes de travail d'examen, vous devez étre connecté

en tant que membre du groupe administrateur de domaine a Windows et Custom Shell.

e Surle serveur INW, vous devez étre connecté en tant que membre du groupe administrateur de domaine a Windows.

2) Lancez Services.msc.

3) Arrétez et désactivez le service de mise a jour de Adobe Reader.

Windows 7 (Acquisition, examen et examen virtuel)

KB Lien Remarques

Effectuez le changement de registre suivant

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00023c00
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KB4490628 Mise

http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=71c7172c-f6ea-493d-ab74-

Rollup mensuel
d'octobre 2018

KB4467107
Rollup mensuel
de

novembre 2018

KB4471318
Rollup mensuel de
décembre 2018

KB4480970
Rollup mensuel de
janvier 2019

KB4486563
Rollup mensuel
de février 2019
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ajour de 65d2548e834b
Servicing Stack
KB4462923 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=d2f075cf-7563-40e7-

9a0a3-8d2562e60cf9

Redémarrage requis \
http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=81c3ab78-c5a5-403b-b347-

0d9421539574

Redémarrage requis

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=345b59c2-a130-42aa-9b98-
066dd085451c

Redémarrage requis

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=4972abbb-3924-406f-8612-
4b6f3ad53442

Redémarrage requis

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=b29b6d12-dbd3-4d44-b0cf-
f6e5e298cab2

Redémarrage requis
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=71c7172c-f6ea-493d-ab74-65d2548e834b
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=71c7172c-f6ea-493d-ab74-65d2548e834b
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=d2f075cf-7563-40e7-9aa3-8d2562e60cf9
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=d2f075cf-7563-40e7-9aa3-8d2562e60cf9
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=81c3ab78-c5a5-403b-b347-0d9421539574
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=81c3ab78-c5a5-403b-b347-0d9421539574
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=345b59c2-a130-42aa-9b98-a66dd085451c
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=345b59c2-a130-42aa-9b98-a66dd085451c
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=4972abbb-3924-406f-8612-4b6f3ad53442
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=4972abbb-3924-406f-8612-4b6f3ad53442
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=b29b6d12-dbd3-4d44-b0cf-f6e5e298cab2
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=b29b6d12-dbd3-4d44-b0cf-f6e5e298cab2

KB4489878
Rollup mensuel
de mars 2019

KB4493472
Rollup mensuel
d'avril 2019

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=039eb986-8841-4931-88e9-

7f429ed74fba

Redémarrage requis

https://www.catalog.update.microsoft.com/ScopedViewlInline.aspx?updateid=c263402a-d44d-4473-bff6-

40e5cc468c82

Redémarrage requis

KB4499164

https://www.catalog.update.microsoft.com/ScopedViewlnline.aspx?updateid=94e0a99a-327b-4a75-a40a-

Rollup mensuel de
mai 2019

b38f0a4el18cf

Redémarrage requis

KB4470641

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=c3ef1b3d-4a92-45b1-b9b6-

Rollup mensuel
.NET
Framework 3.5.1

KB4470637

203d388abela

Redémarrage requis

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=7b427c69-99db-4e3d-838f-

Rollup mensuel
.NET Framework
4.5.2

3d9f5df18a6¢

Effectuez un clic droit sur le fichier et
sélectionnez Exécuter en tant

gu'administrateur.

Remarque : Cette opération sera
extraite dans un emplacement
temporaire et la mise a jour sera
exécutée. Attendez que la fenétre Mise
a jour .Net s'affiche et suivez les
instructions a I'écran
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=039eb986-8841-4931-88e9-7f429ed74fb4
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=039eb986-8841-4931-88e9-7f429ed74fb4
https://www.catalog.update.microsoft.com/ScopedViewInline.aspx?updateid=c263402a-d44d-4473-bff6-40e5cc468c82
https://www.catalog.update.microsoft.com/ScopedViewInline.aspx?updateid=c263402a-d44d-4473-bff6-40e5cc468c82
https://www.catalog.update.microsoft.com/ScopedViewInline.aspx?updateid=94e0a99a-327b-4a75-a40a-b38f0a4e18cf
https://www.catalog.update.microsoft.com/ScopedViewInline.aspx?updateid=94e0a99a-327b-4a75-a40a-b38f0a4e18cf
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=c3ef1b3d-4a92-45b1-b9b6-203d388abe1a
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=c3ef1b3d-4a92-45b1-b9b6-203d388abe1a
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=7b427c69-99db-4e3d-838f-3d9f5df18a6c
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=7b427c69-99db-4e3d-838f-3d9f5df18a6c

Redémarrage requis

KB4480059 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=b8c1b025-fd0a-4c5¢c-9aa8-
Rollup mensuel | 3549f8eef894

.NET Framework

4,5.2

Redémarrage requis

KB3114565 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=f8597b0b-75c8-49e9-b352-
Novembre 2018 | 2c036324dcac

Office 2010 SP2

KB4461570 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=67f17a1d-98a3-4554-8d26-
Décembre 2018 | 21e0e32454d8

Office 2010 SP2

KB2553332 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=c23a7e38-00e6-4565-ac68-
Janvier 2019 fcbcOba37194

Office 2010 SP2

KB4461614 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=e21643f5-d332-490b-94f6-

Janvier 2019 666fbcf37a48

Office 2010 SP2

KB4461466 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=1914e637-8c9a-49fa-8361-
Octobre 2018 2f621e2cblcf

Excel 2010

KB4461577 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=d7419ea5-4069-4e51-bd42-
Décembre 2018 | d6d0f89b0000

Excel 2010

KB4092439 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=2dc153d4-a8a6-461d-bcee-
Octobre 2018 96d16d168ec3

Word 2010

Page 56 sur 80
GE Healthcare/18 octobre 2019


http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=b8c1b025-fd0a-4c5c-9aa8-3549f8eef894
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=b8c1b025-fd0a-4c5c-9aa8-3549f8eef894
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=f8597b0b-75c8-49e9-b352-2c036324dcac
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=f8597b0b-75c8-49e9-b352-2c036324dcac
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=67f17a1d-98a3-4554-8d26-21e0e32454d8
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=67f17a1d-98a3-4554-8d26-21e0e32454d8
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=c23a7e38-0ae6-4565-ac68-fcbc0ba37194
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=c23a7e38-0ae6-4565-ac68-fcbc0ba37194
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=e21643f5-d332-490b-94f6-666fbcf37a48
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=e21643f5-d332-490b-94f6-666fbcf37a48
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=1914e637-8c9a-49fa-8361-2f621e2cb1cf
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=1914e637-8c9a-49fa-8361-2f621e2cb1cf
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=d7419ea5-4069-4e51-bd42-d6d0f89b0000
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=d7419ea5-4069-4e51-bd42-d6d0f89b0000
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=2dc153d4-a8a6-461d-bcee-96d16d168ec3
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=2dc153d4-a8a6-461d-bcee-96d16d168ec3

KB4461625 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=ce188561-f88e-4130-b478- Installez la version linguistique, par
Janvier 2019 c71e737af957 exemple all-wordintl-en-us_... et All-
Word 2010 word-x-none_...

KB4461521 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=e1leedb8e-0c58-4b7d-9da5-

Décembre 2018 | b34066d06ad8

PowerPoint 2010

KB4462230 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=2728f82a-4baf-438c-93bb-

Microsoft 0c6ef3ab2628

Excel 2010

KB3115120 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=57460e64-0e98-46c3-9fdd-

Microsoft 5a6b410b9%e2e

Office 2010

KB3191908 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=3d5594e2-20dc-4714-8b1f-

Microsoft Office
2010

521061557021

KB3213631
Microsoft Office
2010

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=9clelb48-fc01-4698-824c-

4a3767377eae

KB4022206
Microsoft Office
2010

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=bac66ae6-b816-4718-89c2-

0e3af0f223a2

Ignorez le message du programme
d'installation de Windows s'il s'affiche

KB4022208
Microsoft Office
2010

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=2ff1653c-e6e9-41a7-8df7-

bee8lec2dd2c

Ignorez le message du programme
d'installation de Windows s'il s'affiche

KB4462177
Microsoft Office
2010

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=80edffc4-eab0-475b-a4f3-

8b1d531db0dd

KB4462223
Microsoft Office
2010

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=334be4e6-18ce-4d4c-a133-

3¢720d8c1262
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=e1eedb8e-0c58-4b7d-9da5-b34066d06ad8
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=2728f82a-4baf-438c-93bb-0c6ef3ab2628
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=2728f82a-4baf-438c-93bb-0c6ef3ab2628
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=57460e64-0e98-46c3-9fdd-5a6b410b9e2e
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=57460e64-0e98-46c3-9fdd-5a6b410b9e2e
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=3d5594e2-20dc-4714-8b1f-521061557021
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=3d5594e2-20dc-4714-8b1f-521061557021
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=9c1e1b48-fc01-4698-824c-4a3767377eae
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=9c1e1b48-fc01-4698-824c-4a3767377eae
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=bac66ae6-b816-4718-89c2-0e3af0f223a2
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=bac66ae6-b816-4718-89c2-0e3af0f223a2
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=2ff1653c-e6e9-41a7-8df7-6ee81ec2dd2c
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=2ff1653c-e6e9-41a7-8df7-6ee81ec2dd2c
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=80edffc4-eab0-475b-a4f3-8b1d531db0dd
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=80edffc4-eab0-475b-a4f3-8b1d531db0dd
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=334be4e6-18ce-4d4c-a133-3c720d8c1262
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=334be4e6-18ce-4d4c-a133-3c720d8c1262

KB4461623 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=cefe4cf0-ac44-44cd-872b- Installez la version linguistique, par
Microsoft fb6e5c292754 exemple all-wordintl-en-us_... et All-
Outlook 2010 word-x-none._...

KB3128031 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=efdfb48c-174b-4b88-9dbe-

Microsoft Office
2010

18431473ece3

KB4092436
Microsoft Office
2010

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=b8df3741-3ae0-40de-9857-
52ef03468f16

KB4022136
Microsoft
Outlook 2010

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=d2e3b299-dd41-4d04-be4§-

c53abc9705bf

Installez la version linguistique, par
exemple all-wordintl-en-us_... et All-
word-x-none_...

KB4487078 .NET
Framework 3.5.1,
4.5.2

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=30526e5c-5030-4300-8d4c-
c215d1a30349

Installez KB4483455 et KB4483458

KB4340004 .NET
Framework 3.5.1,
4.5.2

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=c52c0560-8129-4649-812d-
08473bb26801

Installez KB4338602

KB4345679 .NET
Framework 3.5.1,
4.5.2

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=1b11fddd-9a22-472e-0412-
ef225a5de41a

Installez KB4344173

KB4487121 .NET
Framework 3.5.1,
45.2

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=5b16b18c-5d7c-4ab0-a6¢cd-
366b2553elb2

Installez KB4483474 et KB4483483

KB4493435
Internet
Explorer 11
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=cefe4cf0-ac44-44cd-872b-fb6e5c292754
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=cefe4cf0-ac44-44cd-872b-fb6e5c292754
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=efdfb48c-174b-4b88-9dbe-18431473ece3
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=efdfb48c-174b-4b88-9dbe-18431473ece3
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=b8df3741-3ae0-40de-9857-52ef03468f16
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=b8df3741-3ae0-40de-9857-52ef03468f16
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=d2e3b299-dd41-4d04-be48-c53abc9705bf
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=d2e3b299-dd41-4d04-be48-c53abc9705bf
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=30526e5c-503a-4300-8d4c-c215d1a30349
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=30526e5c-503a-4300-8d4c-c215d1a30349
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=c52c0560-8129-4649-812d-08473bb26801
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=c52c0560-8129-4649-812d-08473bb26801
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=1b11fddd-9a22-472e-a412-ef225a5de41a
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=1b11fddd-9a22-472e-a412-ef225a5de41a
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=5b16b18c-5d7c-4ab0-a6cd-366b2553e1b2
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=5b16b18c-5d7c-4ab0-a6cd-366b2553e1b2
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=4a2f0647-ecd1-4e6c-9c83-c19f37e7b3e0
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=4a2f0647-ecd1-4e6c-9c83-c19f37e7b3e0

KB3064209 Mise
ajour du
microcode CPU

https://www.microsoft.com/en-us/download/details.aspx?id=47656

Redémarrage requis

Si un message indiquant que la mise &
jour est déja installée sur l'ordinateur
s'affiche, ignorez-le

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust
Providers\Software Publishing]

Désinstallation

State=dword:00010000

Redémarrage requis

de CodeMeter Veuillez consulter la section « FACULTATIF - Désinstallation de CodeMeter »
Windows 2008R2 (Serveur INW)

KB Lien Remarques
Effectuez le changement de registre suivant
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00023c00

KB4490628 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=1d4f0343-a41a-4782-8aed-

Mise a jour de | 180620431171

Servicing

Stack

KB4462923 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=c3e23546-1642-4edc-bdd4-

Rollup mensuel | 932f941f97a1l

d'octobre 2018
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https://www.microsoft.com/en-us/download/details.aspx?id=47656
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=1d4f0343-a41a-4782-8aed-18a620431171
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=1d4f0343-a41a-4782-8aed-18a620431171
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=c3e23546-1642-4edc-bdd4-932f941f97a1
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=c3e23546-1642-4edc-bdd4-932f941f97a1

KB4467107
Rollup mensuel
de

novembre 2018

KB4471318
Rollup mensuel
de

décembre 2018

KB4480970
Rollup mensuel
de janvier 2019

KB4486563
Rollup

mensuel de
février 2019

Redémarrage requis
http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=1f74c5cc-0f12-40e5-a947-

81516alccel?

Redémarrage requis
http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=3df43753-6cbf-40d1-9249-

db8009bbbc7a

Redémarrage requis
http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=baf43ca5-a997-48e2-bb96-

375193004bb8

Redémarrage requis
http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=9ec6ce3a-e6b5-4741-a44b-
01d76ce427d1

Redémarrage requis

KB4489878 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=4f0792e3-3d80-41c3-bc5b-
Rollup 0440b0dfof20
mensuel de
mars 2019
Redémarrage requis
KB4493472 https://www.catalog.update.microsoft.com/ScopedViewlnline.aspx?updateid=c8630c56-66ba-4f5f-8564-
Rollup 30d73f25beb8
mensuel
d'avril 2019
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=1f74c5cc-0f12-40e5-a947-81516a1cce12
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=1f74c5cc-0f12-40e5-a947-81516a1cce12
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=3df43753-6cbf-40d1-9249-db8009bbbc7a
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=3df43753-6cbf-40d1-9249-db8009bbbc7a
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=baf43ca5-a997-48e2-bb96-375193004bb8
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=baf43ca5-a997-48e2-bb96-375193004bb8
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=9ec6ce3a-e6b5-4741-a44b-01d76ce427d1
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=9ec6ce3a-e6b5-4741-a44b-01d76ce427d1
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=4f0792e3-3d80-41c3-bc5b-0440b0df9f20
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=4f0792e3-3d80-41c3-bc5b-0440b0df9f20

Redémarrage requis

KB4499164 https://www.catalog.update.microsoft.com/ScopedViewlnline.aspx?updateid=c832b037-3ac5-4dfb-b43b-
Rollup cd70c004a803
mensuel de
mai 2019
Redémarrage requis
KB4470641 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=437d0478-b891-4d79-b5fb-
Rollup 4b7290d77334
mensuel .NET
Framework
3.5.1
Redémarrage requis
KB4470637 http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=0fe7139a-9081-4151-9b83- Effectuez un clic droit sur le fichier et
Rollup c499dcdb852b exécutez en tant qu'administrateur.
mensuel .NET Remarque : Cette opération sera
Framework extraite dans un emplacement
4.5.2 terpporgire et la mise & jour sera
exécutée. Attendez que la fenétre
Mise & jour .Net s'affiche et suivez les
instructions a I'écran.
Redémarrage requis
KB4480059 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=eab83cf8-4e43-40cc-be52-
Rollup caafOfb1381c
mensuel .NET
Framework
45.2
KB4487078 http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=e220e2c6-d8a8-4a77-b509-
.NET a4db5c3e7736
Framework Installez KB4483455 et
3.5.1,4.5.2 KB4483458
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https://www.catalog.update.microsoft.com/ScopedViewInline.aspx?updateid=c832b037-3ac5-4dfb-b43b-cd70c004a803
https://www.catalog.update.microsoft.com/ScopedViewInline.aspx?updateid=c832b037-3ac5-4dfb-b43b-cd70c004a803
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=437d0478-b891-4d79-b5fb-4b7290d77334
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=437d0478-b891-4d79-b5fb-4b7290d77334
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=0fe7139a-9081-4151-9b83-c499dcdb852b
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=0fe7139a-9081-4151-9b83-c499dcdb852b
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=eab83cf8-4e43-40cc-be52-caaf0fb1381c
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=eab83cf8-4e43-40cc-be52-caaf0fb1381c
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=e220e2c6-d8a8-4a77-b509-a4db5c3e7736
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=e220e2c6-d8a8-4a77-b509-a4db5c3e7736

Explorer 11

KB3064209
Mise a jour du
CPU
Microcode

Redémarrage requis

https://www.microsoft.com/en-us/download/details.aspx?id=47673

KB4487121 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=8f601e2c-ed42-409a-b754-

.NET 3c5f402f4f9a

Framework Installez KB4483474 et
3.5.1,4.5.2 KB4483483
KB4493435 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=23f66904-5d8d-4e14-b06b-

Internet 48157e4d9327

Si un message indiguant que la mise
a jour est déja installée sur
I'ordinateur s'affiche, ignorez-le

Effectuez le changement de registre suivant

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00010000
Redémarrage requis

MLCL V6.9.6 2019 Mises a jour de correctif 7 (Ne s'applique qu'a la nouvelle image)

Cette section s'applique uniguement aux systémes configurés a I'aide de nouvelles images. Reportez-vous aux étapes ci-dessous pour déterminer la version de
l'image que vous exécutez. Les correctifs Microsoft de cette section sont les mémes que ceux de la section de mise & jour 6, & I'exception des correctifs .Net. Les mises
a jour supplémentaires de la section ci-dessus pour la mise @ niveau d'Adobe et la désinstallation de Codemeter ne s'appliquent pas aux nouvelles images car ces
modifications sont déja incorporées dans les images mises a jour.

Déterminez la version d'image de 6.9.6 que vous exécutez en suivant ces étapes ;
1) Connectez-vous aux systéemes MLCL (ACQ, GE REVIEW, INW, VIRTUAL REVIEW) en tant qu'utilisateur disposant de privileges d'administration, par exemple Administrateur.
2) Sélectionnez Windows Start -> Run (Démarrer - > Exécuter), tapez Regedit et Entrée.
3) Dans la fenétre Regedit, accédez a HKEY_LOCAL_MACHINE\SOFTWARE\GE Medical Systems
4) Cliguez sur GE Medical Systems
5) Double-cliquez sur Image Version (Version d'image)
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=8f601e2c-ed42-409a-b754-3c5f402f4f9a
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=8f601e2c-ed42-409a-b754-3c5f402f4f9a
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=23f66904-5d8d-4e14-b06b-48157e4d9327
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=23f66904-5d8d-4e14-b06b-48157e4d9327
https://www.microsoft.com/en-us/download/details.aspx?id=47673

6)

7) Comparez Value Data (Données de la valeur) au tableau ci-dessous pour déterminer si vous exécutez une image ancienne ou nouvelle
8) Quittez la boite de dialogue Regedit.

Systéeme MLCL Anciennes versions d'image Nouvelles versions d'image
ACQ 10192016 12132018
EXAMEN GE 10192016 12132018
INW 10192016 12142018
EXAMEN VIRTUEL 10282016 12172018

Uniquement pour la configuration de systéme a I'aide de nouvelles images.

Windows 7 (Acquisition, examen et examen virtuel)

KB

Lien

Remarques

Effectuez le changement de registre suivant

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust

Providers\Software Publishing]

State=dword:00023c00

Mise a jour de 2440
BIOS a v2.45

KB4490628 Mise a
jour de Servicing
Stack

https://support.hp.com/us-en/drivers/selfservice/hp-z440-workstation/6978828

Redémarrage requis

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=71c7172c-f6ea-493d-

Reportez-vous aux instructions de
mise a jour de Z440 BIOS a v2.45
ci-dessus.

ab74-65d2548e834b

KB4471318 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=345b59c2-a130-42aa-
Rollup mensuel de 9b98-066dd085451c¢
décembre 2018
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https://support.hp.com/us-en/drivers/selfservice/hp-z440-workstation/6978828
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=71c7172c-f6ea-493d-ab74-65d2548e834b
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=71c7172c-f6ea-493d-ab74-65d2548e834b
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=345b59c2-a130-42aa-9b98-a66dd085451c
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=345b59c2-a130-42aa-9b98-a66dd085451c

KB4486563
Rollup mensuel de
février 2019

KB4489878 Rollup
mensuel de
mars 2019

KB4493472 Rollup
mensuel d'avril 2019

KB4499164 Rollup
mensuel de mai 2019

KB2901907

Programme
d'installation de .NET
Framework 4.5.2

Redémarrage requis

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=b29b6d12-dbd3-4d44-
bOcf-f6e5e298cab?2

Redémarrage requis

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=039eb986-8841-4931-
88e9-7f429ed74fb4

Redémarrage requis

https://www.catalog.update.microsoft.com/ScopedViewlInline.aspx?updateid=c263402a-d44d-4473-bff6-

40e5cc468c82
Redémarrage requis

https://www.catalog.update.microsoft.com/ScopedViewlInline.aspx?updateid=94e0a99a-327b-4a75-
040a-b38f0a4el8cf

Redémarrage requis

https://www.microsoft.com/en-us/download/details.aspx?id=42642

Effectuez un clic droit et exécutez en
tant qu'administrateur

KB4019112
.NET Framework

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=1daeb6d1-b103-4baa-bbde-
5326e17e89%4

Exécutez KB4014514 et KB4014504
uniquement. Pour KB4014514,
effectuez un clic droit et exécuter en
tant qu'administrateur,

REMARQUE : Redémarrez si vous
y étes invité.
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=b29b6d12-dbd3-4d44-b0cf-f6e5e298cab2
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=b29b6d12-dbd3-4d44-b0cf-f6e5e298cab2
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=039eb986-8841-4931-88e9-7f429ed74fb4
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=039eb986-8841-4931-88e9-7f429ed74fb4
https://www.catalog.update.microsoft.com/ScopedViewInline.aspx?updateid=c263402a-d44d-4473-bff6-40e5cc468c82
https://www.catalog.update.microsoft.com/ScopedViewInline.aspx?updateid=c263402a-d44d-4473-bff6-40e5cc468c82
https://www.catalog.update.microsoft.com/ScopedViewInline.aspx?updateid=94e0a99a-327b-4a75-a40a-b38f0a4e18cf
https://www.catalog.update.microsoft.com/ScopedViewInline.aspx?updateid=94e0a99a-327b-4a75-a40a-b38f0a4e18cf
https://www.microsoft.com/en-us/download/details.aspx?id=42642
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=1daeb6d1-b103-4baa-bbde-5326e17e89e4
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=1daeb6d1-b103-4baa-bbde-5326e17e89e4

KB4055269
Janvier 2018 .NET
Framework

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=537fc3ba-4248-40b8-

9498-8a671abebfe9

Installez KB4054172, KB4019990 et
KB4054176.

REMARQUE : KB4019990 - Un
message indiquant que ce KB
est déja installé peut s'afficher,
ignorez-le et continuez

KB4095874
.NET 3.5SP1 et
KB4096495 .NET
4.5.2

KB4345590
.NET Framework

http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=d000d6a2-3321-4381-

9024-3345b2cd0435

Redémarrage requis

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=08968031-142d-4dcb-
9fd8-29fbd6ae9960

KB4099633 est le numéro de KB a
utiliser pour télécharger et
installer le correctif pour
KB4095874 et KB4096495. Le
fichier téléchargé contient
plusieurs KB. Suivez ces étapes
d'installation :

1) KB4095874

2) KB4096495 - Faites un
clic droit et exécutez en
tant qu'administrateur

Installez d'abord KB4344149
(redémarrez si vous y étes invité),
puis KB4344152

KB4470637
Rollup mensuel .NET
Framework 4.5.2

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=7b427c69-99db-4e3d-
838f-3d9f5df18a6¢

Effectuez un clic droit sur le fichier et
exécutez en tant qu'administrateur.
Remarque : Cette opération sera
extraite dans un emplacement
temporaire et la mise @ jour sera
exécutée. Attendez que la fenétre
Mise & jour .Net s'affiche et suivez les
instructions & I'écran

KB4480059
Rollup mensuel .NET
Framework 4.5.2

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=b8c1b025-fd0a-4c5c-
9008-3549f8eef894
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=537fc3ba-4248-40b8-9498-8a671abebfe9
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=537fc3ba-4248-40b8-9498-8a671abebfe9
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=d000d6a2-3321-4381-9a24-3345b2cd0435
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=d000d6a2-3321-4381-9a24-3345b2cd0435
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=08968031-142d-4dcb-9fd8-29fbd6ae9960
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=08968031-142d-4dcb-9fd8-29fbd6ae9960
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=7b427c69-99db-4e3d-838f-3d9f5df18a6c
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=7b427c69-99db-4e3d-838f-3d9f5df18a6c
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=b8c1b025-fd0a-4c5c-9aa8-3549f8eef894
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=b8c1b025-fd0a-4c5c-9aa8-3549f8eef894

KB4461570 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=67f17a1d-98a3-4554-

Décembre 2018 8d26-21e0e32454d8

Office 2010 SP2

KB2553332 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=c23a7e38-00e6-4565-

Janvier 2019 Office ac68-fcbcOba37194

2010 SP2

KB4461614 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=e21643f5-d332-490b-

Janvier 2019 Office 94f6-666fbcf37a48

2010 SP2

KB4461466 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=1914e637-8c9a-49fa-

Octobre 2018 Excel 8361-2f621e2cblcf

2010

KB4461577 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=d7419ea5-4069-4e51-

Décembre 2018 bd42-d6d0f89b0000

Excel 2010

KB4092439 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=2dc153d4-a8a6-461d-

Octobre 2018 bcee-96d16d168ec3

Word 2010

KB4461625 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=ce188561-f88e-4130- Installez la version linguistique, par
Janvier 2019 Word b478-c71e737af957 exemple all-wordintl-en-us_... et All-
2010 word-%-none._...
KB4461521 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=eleedb8e-0c58-4b7d-

Décembre 2018 9da5-b34066d06ad8

PowerPoint 2010

KB4462230 Microsoft
Excel 2010

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=2728f82a-4baf-438¢c-
93bb-0cbef3ab2628

KB4462177 Microsoft

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=80edffc4-eab0-475b-a4f3-

Office 2010 8b1d531db0dd
KB4461623 Microsoft | http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=cefe4cf0-acs4-44cd-872b- | Installez la version linguistique, par
Outlook 2010 fb6e5c292754 exemple all-wordintl-en-us_... et All-
word-x-none_...
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=67f17a1d-98a3-4554-8d26-21e0e32454d8
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=67f17a1d-98a3-4554-8d26-21e0e32454d8
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=c23a7e38-0ae6-4565-ac68-fcbc0ba37194
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=c23a7e38-0ae6-4565-ac68-fcbc0ba37194
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=e21643f5-d332-490b-94f6-666fbcf37a48
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=e21643f5-d332-490b-94f6-666fbcf37a48
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=1914e637-8c9a-49fa-8361-2f621e2cb1cf
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=1914e637-8c9a-49fa-8361-2f621e2cb1cf
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=d7419ea5-4069-4e51-bd42-d6d0f89b0000
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=d7419ea5-4069-4e51-bd42-d6d0f89b0000
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=2dc153d4-a8a6-461d-bcee-96d16d168ec3
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=2dc153d4-a8a6-461d-bcee-96d16d168ec3
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=ce188561-f88e-4130-b478-c71e737af957
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=ce188561-f88e-4130-b478-c71e737af957
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=e1eedb8e-0c58-4b7d-9da5-b34066d06ad8
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=e1eedb8e-0c58-4b7d-9da5-b34066d06ad8
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=2728f82a-4baf-438c-93bb-0c6ef3ab2628
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=2728f82a-4baf-438c-93bb-0c6ef3ab2628
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=80edffc4-eab0-475b-a4f3-8b1d531db0dd
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=80edffc4-eab0-475b-a4f3-8b1d531db0dd
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=cefe4cf0-ac44-44cd-872b-fb6e5c292754
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=cefe4cf0-ac44-44cd-872b-fb6e5c292754

KB4487078 .NET http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=30526e5c-503a-4300- Installez KB4483455 et KB4483458
Framework 3.5.1, 8d4c-c215d1a30349

4.5.2

KB4487121 .NET http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=5b16b18c-5d7c-4ab0- Installez KB4483474 et KB4483483
Framework 3.5.1, a6cd-366b2553e1b2

4.5.2

KB4493435 Internet | http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=4a2f0647-ecd1-4ebc-

Explorer 11 9¢83-c19f37e7b3e0

Redémarrage requis

Mise a jour de Z440 https://support.hp.com/us-en/drivers/selfservice/hp-z440-workstation/6978828 Reportez-vous aux instructions de
BIOS vers mise a jour de Z440 BIOS a v2.47
v2.47 SP93482 ci-dessus.

Effectuez le changement de registre suivant

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust
Providers\Software Publishing]

State=dword:00010000

Redémarrage requis

Windows 2008R2 (Serveur INW)

KB Lien Remarques
Effectuez le changement de registre suivant
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00023c00
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=30526e5c-503a-4300-8d4c-c215d1a30349
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=30526e5c-503a-4300-8d4c-c215d1a30349
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=5b16b18c-5d7c-4ab0-a6cd-366b2553e1b2
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=5b16b18c-5d7c-4ab0-a6cd-366b2553e1b2
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=4a2f0647-ecd1-4e6c-9c83-c19f37e7b3e0
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=4a2f0647-ecd1-4e6c-9c83-c19f37e7b3e0
https://support.hp.com/us-en/drivers/selfservice/hp-z440-workstation/6978828

Rollup mensuel
de
décembre 2018

KB4480970
Rollup mensuel
de janvier 2019

KB4486563
Rollup

mensuel de
février 2019

KB4489878
Rollup
mensuel de
mars 2019
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db8009bbbc7a

Redémarrage requis
http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=baf43ca5-a997-48e2-bb96-

375193004bb8

Redémarrage requis
http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=9ec6ce3a-e6b5-4741-a44b-

01d76ce427d1

Redémarrage requis
http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=4f0792e3-3d80-41c3-bc5b-

0440b0dfof20

Redémarrage requis

GE Healthcare/18 octobre 2019

HPESBHF03874 | https://support.hpe.com/hpsc/swd/public/detail?sp4ts.oid=1009483731&swlitemld=MTX_2fad1lbbda82e4d5ca06

rév.1 ML350 730a1b43&swENVOid=4184 Reportez-vous aux instructions de

Gen9 mise a jour de Gen9 BIOS a la

(CP035797) version du 21/5/2018 ci-dessus
Redémarrage requis

KB4490628 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=1d4f0343-a41a-4782-8aed-

Mise a jourde | 180620431171

Servicing

Stack

KB4471318 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=3df43753-6¢bf-40d1-9249-



https://support.hpe.com/hpsc/swd/public/detail?sp4ts.oid=1009483731&swItemId=MTX_2fad1bbda82e4d5ca0673a1b43&swEnvOid=4184
https://support.hpe.com/hpsc/swd/public/detail?sp4ts.oid=1009483731&swItemId=MTX_2fad1bbda82e4d5ca0673a1b43&swEnvOid=4184
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=1d4f0343-a41a-4782-8aed-18a620431171
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=1d4f0343-a41a-4782-8aed-18a620431171
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=3df43753-6cbf-40d1-9249-db8009bbbc7a
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=3df43753-6cbf-40d1-9249-db8009bbbc7a
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=baf43ca5-a997-48e2-bb96-375193004bb8
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=baf43ca5-a997-48e2-bb96-375193004bb8
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=9ec6ce3a-e6b5-4741-a44b-01d76ce427d1
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=9ec6ce3a-e6b5-4741-a44b-01d76ce427d1
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=4f0792e3-3d80-41c3-bc5b-0440b0df9f20
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=4f0792e3-3d80-41c3-bc5b-0440b0df9f20

KB4493472
Rollup mensuel
d'avril 2019

KB4499164
Rollup
mensuel de
mai 2019

https://www.catalog.update.microsoft.com/ScopedViewlInline.aspx?updateid=c8630c56-66ba-4f5f-8564-
30d73f25beb8

Redémarrage requis
https://www.catalog.update.microsoft.com/ScopedViewlInline.aspx?updateid=c832b037-3ac5-4dfb-b43b-

cd70c004a803

Redémarrage requis

KB2901907 https://www.microsoft.com/en-us/download/details.aspx?id=42642 Effectuez un clic droit et exécutez en

Programme tant qu'administrateur

d'installation

de .NET

Framework

45.2

KB4019112 https://www.catalog.update.microsoft.com/ScopedViewlnline.aspx?updateid=dedeabda-e039-487b-8ec6- Exécutez KB4014514 et KB4014504

NET 27295517165 uniquement. Pour KB4014514,

Framework effectuez un clic droit et exécuter en
tant qu'administrateur,
REMARQUE : Redémarrez si
vous y étes invité.

KB4054172 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=fdecaf44-50a3-4667-0935- KB4055269 est le numéro de KB a

Janvier 2018 f9e7afObb317 utiliser pour télécharger et installer

NET KB4054172, KB4019990 et
KB4054176

Framework REMARQUE : KB4019990 - Un
message indiquant que ce KB
est déja installé peut s'afficher,
ignorez-le et continuez

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=62ccd808-b5a5-4be9-8a38- KB4099633 est le numéro de KB a
8e20829e29d1 utiliser pour télécharger et
KB4095874 installer le correctif pour
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https://www.catalog.update.microsoft.com/ScopedViewInline.aspx?updateid=c8630c56-66ba-4f5f-8564-30d73f25beb8
https://www.catalog.update.microsoft.com/ScopedViewInline.aspx?updateid=c8630c56-66ba-4f5f-8564-30d73f25beb8
https://www.catalog.update.microsoft.com/ScopedViewInline.aspx?updateid=c832b037-3ac5-4dfb-b43b-cd70c004a803
https://www.catalog.update.microsoft.com/ScopedViewInline.aspx?updateid=c832b037-3ac5-4dfb-b43b-cd70c004a803
https://www.microsoft.com/en-us/download/details.aspx?id=42642
https://www.catalog.update.microsoft.com/ScopedViewInline.aspx?updateid=dedea6da-e039-487b-8ec6-2729551f7165
https://www.catalog.update.microsoft.com/ScopedViewInline.aspx?updateid=dedea6da-e039-487b-8ec6-2729551f7165
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=fdecaf44-50a3-4667-a935-f9e7af0bb317
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=fdecaf44-50a3-4667-a935-f9e7af0bb317
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=62ccd808-b5a5-4be9-8a38-8e2a829e29d1
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=62ccd808-b5a5-4be9-8a38-8e2a829e29d1

.NET 3.5SP1 et

KB4095874 et KB4096495. Le

KB4096495 fichier téléchargé contient
.NET 4.5.2 plusieurs KB. Suivez les étapes
d'installation suivantes :
1) KB4095874
2) KB4096495 - Effectuez
un clic droit et
exécutez en tant
gu'administrateur
KB4345590 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=14afae30-094f-4dca-ba5f- Installez d'abord KB4344149
NET e22347edbosf (redémarrez si vous y étes invité),
Framework - puis KB4344152
Redémarrage requis
KB4470637 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=0fe7139a-9081-4151-9b83- Effectuez un clic droit sur le fichier et
Rollup c499dcdb852b exécutez en tant qu'administrateur.
mensuel NET Remarque : Cette opération sera
Framework extraite dons un emplggement
4.5.2 terpporglre et la mise & jour sera
- exécutée. Attendez que la fenétre
Mise & jour .Net s'affiche et suivez les
instructions a I'écran.
KB4480059 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=eab83cf8-4e43-40cc-be52-
Rollup caafOfb1381c
mensuel .NET
Framework
4.5.2
KB4487078 http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=e220e2c6-d8a8-4a77-b509-
.NET a4db5c3e7736
Framework Installez KB4483455 et
3.5.1,4.5.2 KB4483458
KB4487121 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=8f601e2c-ed42-409a-b754- Installez KB4483474 et
.NET 3c5f402f4f9a KB4483483
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=14afae30-094f-4dca-ba5f-e22347edb98f
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=14afae30-094f-4dca-ba5f-e22347edb98f
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=0fe7139a-9081-4151-9b83-c499dcdb852b
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=0fe7139a-9081-4151-9b83-c499dcdb852b
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=eab83cf8-4e43-40cc-be52-caaf0fb1381c
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=eab83cf8-4e43-40cc-be52-caaf0fb1381c
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=e220e2c6-d8a8-4a77-b509-a4db5c3e7736
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=e220e2c6-d8a8-4a77-b509-a4db5c3e7736
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=8f601e2c-ed42-409a-b754-3c5f402f4f9a
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=8f601e2c-ed42-409a-b754-3c5f402f4f9a

Framework

3.5.1,4.5.2

KB4493435 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=23f66904-5d8d-4e14-b06b-
Internet 48157e4d9327

Explorer 11

Effectuez le changement de registre suivant
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00010000

Redémarrage requis

MLCL V6.9.6 2019 Mises a jour de correctif 8 (S'applique a lI'ancienne et a la nouvelle image)
Les correctifs suivants actualisent le niveau de correctifs du systeme MLCL et résolvent plusieurs vulnérabilités de sécurité. Les directives suivantes s'appliquent :

1) Les correctifs ci-dessus sont des correctifs requis pour 6.9.6 et doivent étre appliqués en premier.

2) Faites attention @ la section Notes d'instructions particulieres de manipulation

3) Les correctifs doivent étre appliqués dans l'ordre, sauf dans les cas indiqués.

4) Lesredémarrages ne sont obligatoires que quand c'est précisé. Si un correctif nécessite un redémarrage @ un autre moment, le systéme peut étre redémarré,

mais ce n'est pas nécessaire.

Instructions d'installation du correctif de Adobe 12 (19.012.20034)
Suivez les instructions ci-dessous pour installer et configurer Adobe Reader DC MUI sur le systeme d'acquisition 6.9.6 R1, le poste de travail d'examen et le serveur
INW.

- Correctif (Adobe Acrobat Reader MUI DC (Continuous Track) update - Toutes les langues) :

Emplacement/URL Version Remarques
https://supportdownloads.adobe.com/detail.jsp?ftplD=6693 | 2019.012.20034 La version V2019.008.20081 du correctif est
testée et qualifiée pour l'installation

1) Notez les exigences de connexion suivantes :
e Surles systéemes d'acquisition autonomes, vous devez étre connecté en tant que membre du groupe administrateur local @ Windows et Custom Shell.
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e Surles systemes d'acquisition en réseau, les postes de travail d'examen, vous devez étre connecté
en tant que membre du groupe administrateur de domaine a Windows et Custom Shell.
e Surle serveur INW, vous devez étre connecté en tant que membre du groupe administrateur de domaine & Windows.
2) Accédez a I'emplacement du programme d'installation adobe, double-cliquez sur AcroRdrbDCUpd1901220034_MUI.msp et sélectionnez Open (Ouvrir).

3) Attendez que l'installation de Windows soit terminée.

4) Cliquez sur Update (Mettre & jour).

5) Lorsque l'invite du Contréle d'acces utilisateur s'affiche, cliquez sur Yes (Oui) pour continuer
6) Attendez que l'installation du correctif soit terminée.

7) Cliquez sur Finish (Terminer).

Windows 7 (Acquisition, examen et examen virtuel)

KB Lien Remarques
Effectuez le changement de registre suivant
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00023c00

KB4503292 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=c3b33c94-4178-4957-alc4-

Rollup £6272b160182

mensuel de

juin 2019
Redémarrage requis

KB4507449 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=30651730-f83e-4702-9dd9-

Rollup feab76438aed

mensuel de

juillet 2019
Rede arrage reqg

KB4018313 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=b10524c1-71cf-4b9f-956a-

Microsoft 5dc8d8502919

Office 2010
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=c3b33c94-4178-4957-a1c4-e6272b16a182
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=c3b33c94-4178-4957-a1c4-e6272b16a182
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=30651730-f83e-4702-9dd9-feab76438aed
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=30651730-f83e-4702-9dd9-feab76438aed

KB4464567 http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=dc49e69c-71ca-46ef-8afc-

Microsoft 90257dd60246

Office 2010

KB4461619 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=369edcb8-e930-4f3f-a93c-

Microsoft fefa6b7012dd

Word 2010

KB4462224 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=a9aa79ea-0e8f-4d55-a55¢-

Microsoft 5e5a82ad5f4l

Office 2010

KB4464572 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=72bbbf9a-584a-49ed-af5b-

Microsoft 03248bc5a9ce

Excel 2010

KB4462174 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=0ddf0ad9-d785-4cle-b472-

Microsoft 40f7132015d8

Office 2010

Redémarrage requis

KB4507420 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=85b53f91-8683-4db9-a2c2- Installez uniquement les fichiers de

.NET cbacac4doedf configuration répertoriés ci-dessous

Framework - et ignorez les autres fichiers :
1) ndp45-kb4507001-

3-5.1,45.2 x86_3%6e8aa676ccfe1a27a9bbe1fbaa93ae
b87e91fb.exe
2) windows6.1-kb4507004-
x86_625917bdc06b040d7c312e1b8d805a4
3ff31cf8b.msu

Redémarrage requis

KB4507434 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=9f31d69d-d28d-401d-a3b6-

Internet 9019ce60987f

Explorer 11

Page 73 sur 80

GE Healthcare/18 octobre 2019



http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=dc49e69c-71ca-46ef-8afc-90257dd60246
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=dc49e69c-71ca-46ef-8afc-90257dd60246
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=369edcb8-e930-4f3f-a93c-fefa6b7012dd
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=369edcb8-e930-4f3f-a93c-fefa6b7012dd
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=a9aa79ea-0e8f-4d55-a55c-5e5a82ad5f41
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=a9aa79ea-0e8f-4d55-a55c-5e5a82ad5f41
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=72bbbf9a-584a-49ed-af5b-03248bc5a9ce
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=72bbbf9a-584a-49ed-af5b-03248bc5a9ce
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=0ddf0ad9-d785-4c1e-b472-40f7132015d8
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=0ddf0ad9-d785-4c1e-b472-40f7132015d8
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=85b53f91-8683-4db9-a2c2-c6acac4d96df
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=85b53f91-8683-4db9-a2c2-c6acac4d96df
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=9f31d69d-d28d-401d-a3b6-9019ce60987f
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=9f31d69d-d28d-401d-a3b6-9019ce60987f

KB4474419
Mise a jour
pour la prise
en charge du
code de
signature
SHA-2

KB4512506
Rollup
mensuel
d'aodt 2019

Redémarrage requis

https://www.catalog.update.microsoft.com/ScopedViewlInline.aspx?updateid=77e7077c-a23b-4d6e-ac42-
60120fbd3c37

Redémarrage requis

https://www.catalog.update.microsoft.com/ScopedViewlInline.aspx?updateid=70fb559¢c-f9e7-4c56-9d47-
68cfOffe68a2

Effectuez le changement de registre suivant

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00010000

Redémarrage requis

Windows 2008R2 (Serveur INW)

KB

Lien

Remarques

Effectuez le changement de registre suivant

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]
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https://www.catalog.update.microsoft.com/ScopedViewInline.aspx?updateid=77e7077c-a23b-4d6e-ac42-6a120fbd3c37
https://www.catalog.update.microsoft.com/ScopedViewInline.aspx?updateid=70fb559c-f9e7-4c56-9d47-68cf0ffe68a2
https://www.catalog.update.microsoft.com/ScopedViewInline.aspx?updateid=70fb559c-f9e7-4c56-9d47-68cf0ffe68a2

State=dword:00023c00

KB4503292
Rollup
mensuel de
juin 2019

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=84167563-985e-4b02-0e56-
ee75fa0le744

Redémarrage requis

KB4507449
Rollup

mensuel de
juillet 2019

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=3c284887-eala-4c2b-9e34-

00eaabes4cOf

Redémarrage requis

KB4507420
NET
Framework
3.5.1,45.2

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=63be6bae4-edc2-4100-bf2c-
15d3f2d51f30

Redémarrage requis

KB4507434
Internet
Explorer 11

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=86517a70-4a9b-4551-b46c-

Installez uniquement les fichiers de
configuration répertoriés ci-
dessous et ignorez les autres
fichiers :

1) ndp45-kb4507001-
x64_beOdaee8df411dedfc9fdbcOb3eaf
d20af3afeb0.exe

2) windows6.1-kb4507004-
x64_a7d988d65422c8cfbbed141c95ae
ea37a8743167.msu

2c4d7497b64af

Redémarrage requis

KB4474419
Mise a jour
SHA-2 code
signing
support

https://www.catalog.update.microsoft.com/ScopedViewlInline.aspx?updateid=c4b6b6d8-f1a6-4134-9bb5-
d739415c2637
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http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=3c284887-ea1a-4c2b-9e34-00eaa6e44c0f
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=3c284887-ea1a-4c2b-9e34-00eaa6e44c0f
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=63be6ae4-edc2-4100-bf2c-15d3f2d51f30
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=63be6ae4-edc2-4100-bf2c-15d3f2d51f30
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=86517a70-4a9b-4551-b46c-2c4d7497b64f
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=86517a70-4a9b-4551-b46c-2c4d7497b64f
https://www.catalog.update.microsoft.com/ScopedViewInline.aspx?updateid=c4b6b6d8-f1a6-4134-9bb5-d739415c2637
https://www.catalog.update.microsoft.com/ScopedViewInline.aspx?updateid=c4b6b6d8-f1a6-4134-9bb5-d739415c2637

Redémarrage requis

KB4512506
Rollup
mensuel
d'aodit 2019

https://www.catalog.update.microsoft.com/ScopedViewlInline.aspx?updateid=82bf6959-36ff-4d3e-a909-

b1cfoffc9880

Effectuez le changement de registre suivant

Publishing]

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software

State=dword:00010000

Redémarrage requis

Mises d jour de sécurité MLCL v6.9.6 facultatives

Les mises a jour facultatives suivantes peuvent étre appliquées pour améliorer le profil de sécurité des systemes MLCL. Ces mises a jour devraient étre évaluées au cas par cas
conformément a la stratégie informatique. Les modifications de configuration dans cette section sont compatibles avec la fonctionnalité du produit MLCL mais peuvent avoir
un impact informatique sur le site, car les protocoles SSL hérités s'en verront désactivés, ce qui empéchera I'utilisation du bureau a distance et nécessitera une maintenance et

une génération

de certificat.

Parametres de sécurité et correctifs supplémentaires

Serveur INW

Acquisition - Mac-Lab IT/XT/XTi,
CardioLab IT/XT/XTi et SpecialsLab

Poste de travail client GE de
consultation

Revue virtuelle

Correctif URL de téléchargement URL de téléchargement URL de téléchargement URL de téléchargement
MS16-047 https://technet.microsoft.com/library/s | https://technet.microsoft.com/library/s | https://technet.microsoft.com/library/s | https://technet.microsoft.com/library/s
KB3149090 ecurity/MS16-047 ecurity/MS16-047 ecurity/MS16-047 ecurity/MS16-047
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https://www.catalog.update.microsoft.com/ScopedViewInline.aspx?updateid=82bf6959-36ff-4d3e-a909-b1cf9ffc9880
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https://technet.microsoft.com/library/security/MS16-047
https://technet.microsoft.com/library/security/MS16-047
https://technet.microsoft.com/library/security/MS16-047
https://technet.microsoft.com/library/security/MS16-047
https://technet.microsoft.com/library/security/MS16-047
https://technet.microsoft.com/library/security/MS16-047

Serveur INW

Acquisition - Mac-Lab IT/XT/XTi,
CardioLab IT/XT/XTi et SpecialsLab

Poste de travail client GE de
consultation

Revue virtuelle

Plug-in 20007 - | Voir la section - Comment installer le Voir la section - Comment installer le Voir la section - Comment installer le Voir la section - Comment installer le
Désactiver SSL | Plug-in 20007 - Désactiver SSLV2/V3 - | plug-in 20007 - Désactiver SSLV2/V3 - | plug-in 20007 - Désactiver SSLV2/V3 - | Plug-in 20007 - Désactiver SSL V2/V3 -
V2/V3 - KB187498 KB187498 KB187498 KB187498

KB187498

Plug-in 78479 - | Pas de changement nécessaire. L'étape | Pas de changement nécessaire. L'étape | Pas de changement nécessaire. L'étape | Pas de changement nécessaire. L'étape
Poodle ci-dessus répare ceci. ci-dessus répare ceci. ci-dessus répare ceci. ci-dessus répare ceci.

Plug-in 35291 - | Voir la section - Comment installer le Voir la section - Comment installer le Voir la section - Comment installer le Voir la section - Comment installer le

Hachage faible

plug-in 35291 - Hachage faible

(Reportez-vous d
https://technet.microsoft.com/en-

plug-in 35291 - Hachage faible

(Reportez-vous d
https://technet.microsoft.com/en-

plug-in 35291 - Hachage faible

(Reportez-vous d
https://technet.microsoft.com/en-

plug-in 35291 - Hachage faible

(Reportez-vous d
https://technet.microsoft.com/en-

us/library/ms191192(v=sql.105).aspx

us/library/ms191192(v=sql.105).aspx

us/library/ms191192(v=sql.105).aspx

us/library/ms191192(v=sql.105).aspx

pour plus d'informations)

pour plus d'informations)

pour plus d'informations)

pour plus d'informations)

Plug-in 45411 | Pas de changement nécessaire. L'étape | Pas de changement nécessaire. L'étape | Pas de changement nécessaire. L'étape | Pas de changement nécessaire. L'étape
ci-dessus répare ceci. ci-dessus répare ceci. ci-dessus répare ceci. ci-dessus répare ceci.

Plug-in 65821 - | Voir la section - Comment installer le Voir la section - Comment installer le Voir la section - Comment installer le Voir la section - Comment installer le

Suites de plug-in 65821 - Suites de chiffrement plug-in 65821 - Suites de chiffrement plug-in 65821 - Suites de chiffrement plug-in 65821 - Suites de chiffrement

chiffrement SSL | SSL RC4 prises en charge (bar Mitzvahl | sg1 rey prises en charge (bar Mitzvah) | SSL RC4 prises en charge (bar Mitzvah) | SSERC4 prises en charge (bar Mitzvahl

RC4 prises en

charge (bar

Mitzvah)

Plug-in 63155 - | Voir la section - Comment supprimer Voir la section - Comment supprimer Voir la section - Comment supprimer Voir la section - Comment supprimer

Enumération de
chemin d'acceés

une vulnérabilité pour le plug-in 63155
- Enumération de chemin d'accés du
service Microsoft Windows sans

une vulnérabilité pour le plug-in 63155
- Enumération de chemin d'accés du

une vulnérabilité pour le plug-in 63155
- Enumération de chemin d'accés du

une vulnérabilité pour le plug-in 63155
- Enumération de chemin d'accés du

du service Lillemets service Microsoft Windows sans service Microsoft Windows sans service Microsoft Windows sans
Microsoft 9 guillemets guillemets guillemets

Windows sans

guillemets

Plug-in 59915- | S/O Veuillez suivre la section intitulée Veuillez suivre la section intitulée Veuillez suivre la section intitulée
Des « Disable the Sidebar in the system « Disable the Sidebar in the system « Disable the Sidebar in the system

vulnérabilités

Registry » (Désactiver la barre latérale

Registry » (Désactiver la barre latérale

Registry » (Désactiver la barre latérale
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https://technet.microsoft.com/en-us/library/ms191192(v=sql.105).aspx
https://technet.microsoft.com/en-us/library/ms191192(v=sql.105).aspx
https://technet.microsoft.com/en-us/library/ms191192(v=sql.105).aspx
https://technet.microsoft.com/en-us/library/ms191192(v=sql.105).aspx
https://technet.microsoft.com/en-us/library/ms191192(v=sql.105).aspx
https://technet.microsoft.com/en-us/library/ms191192(v=sql.105).aspx

Serveur INW

Acquisition - Mac-Lab IT/XT/XTi,
CardioLab IT/XT/XTi et SpecialsLab

Poste de travail client GE de
consultation

Revue virtuelle

dans les
gadgets
pourraient
permettre
I'exécution de
code a distance

dans le registre systéeme) dans l'article
suivant :
https://technet.microsoft.com/library/s

dans le registre systéeme) dans l'article
suivant :
https://technet.microsoft.com/library/s

ecurity/2719662

ecurity/2719662

dans le registre systéeme) dans l'article
suivant :
https://technet.microsoft.com/library/s
ecurity/2719662

Désactiver le

Veuillez consulter la section Comment

Veuillez consulter la section Comment

Veuillez consulter la section Comment

Veuillez consulter la section Comment

Protocole SMB1 | désactiver le Protocole SMB1 désactiver le Protocole SMB1 désactiver le Protocole SMB1 désactiver le Protocole SMB1
Configurer la Veuillez vous reporter a la section Veuillez vous reporter & la section Veuillez vous reporter & la section Veuillez vous reporter & la section
signature « FACULTATIF - Configuration de la « FACULTATIF - Configuration de la « FACULTATIF - Configuration de la « FACULTATIF - Configuration de la

SMBV2 requise

signature SMBv2 requise - Signature
SMBv2 non requise »

signature SMBv2 requise - Signature
SMBv2 non requise »

signature SMBv2 requise - Signature
SMBv2 non requise »

signature SMBv2 requise - Signature
SMBv2 non requise »

Supprimer les Veuillez vous reporter @ la section S/0 S/0 S/0

utilisateurs « FACULTATIF - Supprimer les

authentifiés utilisateurs authentifiés d'un partage

d'un partage sur le serveur INW »

sur le serveur

INW

Nettoyage du S/0 S/0 Veuillez vous reporter @ la section Veuillez vous reporter @ la section
disque C: « FACULTATIF : nettoyage du « FACULTATIF : nettoyage du disque

disque C:»

C»

Désactiver
Remote
Desktop
Services

Veuillez vous reporter @ la section

« FACULTATIF - Vulnérabilité de
l'exécution & distance du code Remote
Desktop Services »

Veuillez vous reporter a la section

« FACULTATIF - Vulnérabilité de
l'exécution a distance du code Remote
Desktop Services »

Veuillez vous reporter a la section

« FACULTATIF - Vulnérabilité de
l'exécution a distance du code Remote
Desktop Services »

Veuillez vous reporter a la section

« FACULTATIF - Vulnérabilité de
l'exécution a distance du code Remote
Desktop Services »

Stratégie de mot de passe
Stratégie de mot de passe : La longueur minimale du mot de passe peut étre modifiée au-dela de la limite de 14 caractéres pour répondre aux exigences de sécurité.

Reportez-vous a la section Mot de passe du Guide de sécurité pour plus d'informations sur la modification des mots de passe.
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Suppression facultative de Adobe Reader sur le serveur INW
Nous recommandons de désinstaller Adobe Reader sur le serveur INW. Sur le serveur, Adobe Reader n'est utilisé que pour consulter le manuel de l'opérateur
INW. Le manuel est disponible au format imprimé et via le portail du manuel en ligne.

Recommandations supplémentaires sur la sécurité des systemes MLCL
Nous vous recommandons vivement de suivre les recommandations suivantes :
e Sélectionnez un mot de passe par défaut plus complexe, plus sécurisé et unique pour chaque compte d'utilisateur
o Désactivez RDP pour chaque systéme en procédant comme suit :
o My Computer>Properties>Remote settings>Remote (Mon Ordinateur > Propriétés > Paramétres > A distance)
o Cochez 'option « Don’t allow connections to this computer » (Ne pas autoriser les connexions a cet ordinateur).
o Cliquez sur OK et redémarrez.

o Sila fonctionnalité Insite n'est pas utilisée sur le systéeme, désactivez le service VNC en procédant comme suit :
Cliquez sur le bouton Start (Démarrer)

Cliquez sur Control Panel (Panneau de configuration)

Cliquez sur Administrative Tools (Outils d'administration)

Double-cliquez sur Services

Faites un clic droit sur TightVNC Server et sélectionnez Properties (Propriétés)

Sous Startup type (Type de démarrage), sélectionnez Disabled (Désactivé) dans la liste déroulante
Cliquez sur Apply (Appliquer), puis sur OK

O O O O O O O

Nous vous recommandons également de suivre ces recommandations générales et les recommandations répertoriées dans le guide de sécurité MLCL
o Renforcement de la sécurité physique

Pare-feux réseau

Instauration de zones démilitarisées et défenses de périmétre pour le réseau du site

Systémes de détection d'intrusion - systéme de protection d'intrusion réseau

Réseaux privés virtuels

Analyse de trafic réseau

Analyse des journaux
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Coordonnées

Si vous avez des questions supplémentaires, veuillez contacter notre assistance technique.
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